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What's New

1 What's New

New features in ODBC Driver for Oracle 5.1

¢ Fixed connection timeout setting before opening connection
¢ Improved compatibility with FileMaker Server for Linux and macOS
¢ Now passwords are stored in an encrypted form in the DSN record

e Added Read Only mode for connection

New features in ODBC Driver for Oracle 5.0
e Added support for Oracle 23c

¢ Improved compatibility with 4D in macOS

New features in ODBC Driver for Oracle 4.3

¢ Added support for SQL_ATTR_MAX_ROWS attribute
¢ Improved compatibility with Visual Basic in Visual Studio

e Added support for macOS 13 Ventura

Improved compatibility with Tableau Prep Builder

Improved compatibility with Crystal Reports

Improved the SSH connection establishment

Reduced number of metadata calls

New features in ODBC Driver for Oracle 4.2

e Added support for Windows 11

Improved compatibility with FICO Mosel

Improved compatibility with FileMaker

Improved compatibility with JMP on macOS

Improved support for an ODBC installer on Windows 2000

New features in ODBC Driver for Oracle 4.2

© 2024 Enter your company name



ODBC Driver for Oracle

e Added support for Windows 11

Improved compatibility with FICO Mosel

Improved compatibility with FileMaker

Improved compatibility with JMP on macOS

Improved support for an ODBC installer on Windows 2000

New features in ODBC Driver for Oracle 4.1
e MSlinstaller for deploying through GPO is added

New features in ODBC Driver for Oracle 4.0

e Apple Silicon M1 is supported
¢ Oracle 21c is supported

e Compatibility with macOS Big Sur is improved

New features in ODBC Driver for Oracle 3.3

e Oracle 20c is supported
e Connection via SSL protocol is supported
e Connection via SSH protocol is supported

e Connection via HTTP tunnel is supported

New features in ODBC Driver for Oracle 3.2

¢ | ong database object names are supported

e Possibility of mapping DATE time to SQL_TYPE_DATE rather than
SQL_TYPE_TIMESTAMP is added

e Compatibility with Power Pivot is improved

e Compatibility with Visual Basic is improved

e Compatibility with RStudio is improved

New features in ODBC Driver for Oracle 3.1

e Oracle 19c is supported
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Now ODBC driver is thread-safe

Now ODBC driver activation does not require administrator privileges

Improved compatibility with sandboxed applications for macOS

Support for connection pooling is improved

New features in ODBC Driver for Oracle 3.0

e Oracle 18c is supported

e Now ODBC driver for macOS is distributed as a PKG package

e Now ODBC driver for Linux is distributed as DEB and RPM packages
e Possibility to force the ODBC 2.x behavior is added

New features in ODBC Driver for Oracle 2.4

e Possibility to return String Types as Ansi or Unicode is added
e Compatibility with MS Access is improved

e Compatibility with Tableau is improved

e Compatibility with Omnis Studio is improved

e Compatibility with Power Pivot is improved

e Compatibility with DBeaver is improved

New features in ODBC Driver for Oracle 2.3

¢ Performance of batch operations is significantly improved

New features in ODBC Driver for Oracle 2.2

e Compatibility with SAS JMP is improved

e Compatibility with MS Power Query is improved

e OUTER JOIN macros in SQL queries are supported
e DateTime macros in SQL queries are supported

e Scalar function macros in SQL queries are supported

e NChar literal replacement is supported
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¢ Retrieving Metadata for Oracle 8 is improved

New features in ODBC Driver for Oracle 2.1

e Oracle Cloud in the Direct mode is supported

e Option for showing meta data only for the current scheme is added
e Compatibility with MS Visual Studio

e Compatibility with MS FoxPro is improved

e Compatibility with Maplnfo is improved

e Compatibility with Libre Office is improved

e Compatibility with Qlik is improved

e Compatibility with Delphi & C++Builder is improved

e MS Access linked tables support is improved

New features in ODBC Driver for Oracle 2.0

e Linux is supported

e macOS is supported

e Support for stored procedures and functions is improved

e Backward compatibility of SQLExecDirect with ODBC 2.x is improved

e Compatibility with MS Excel is improved

e Compatibility with ODBC 2.x is improved

e Bug with Trial expiration in Microsoft SQL Server Management Studio is fixed

¢ Bug with fetching big data amount is fixed

New features in ODBC Driver for Oracle 1.2

e Compatibility with Microsoft Visual Studio is improved

e Compatibility with Microsoft Office is improved

e Compatibility with Microsoft SQL Server Management Studio is improved
e Compatibility with Crystal Reports is improved

e Compatibility with ClikView is improved
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e Stored procedures metadata support is improved

e Interval data types support is improved

New features in ODBC Driver for Oracle 1.1

e Performance is improved

New features in ODBC Driver for Oracle 1.0

¢ First release of ODBC Driver for Oracle
e Windows 32-bit is supported
e Windows 64-bit is supported

© 2015-2024
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2 General Information

1. Overview

2. Features

3. Compatibility
4. Requirements

5. Licensing
6. Getting Support
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21 Overview

Overview

ODBC Diriver for Oracle is a high-performance connectivity solution with enterprise-level

features for accessing Oracle databases from ODBC-compliant reporting, analytics, Bl, and
ETL tools on both 32-bit and 64-bit Windows, macOS, and Linux. Our ODBC driver fully
supports standard ODBC API functions and data types and enables easy and secure access

© 2024 Enter your company name


https://www.devart.com/company/contactform.html?category=0&product=odbc/oracle
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/oracle/feedback.html
https://www.devart.com/company/contactform.html?category=0&product=odbc/oracle
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/oracle/feedback.html
https://www.devart.com/odbc/oracle/

ODBC Driver for Oracle

to live Oracle data from anywhere.

v ODBC API
ODBC Data -
Types

Direct Connection

Our data connector enables various ODBC-aware applications to establish a direct
connection to Oracle via TCP/IP to eliminate the need for Oracle Client. Direct connection
increases the speed of data transmission between an external application and Oracle, which
is crucial for data analysis in real time. It also streamlines the deployment process, since
there is no need to distribute any additional client software with the driver. You can also
connect to Oracle using the native Oracle client library.

Compatibility

ODBC Driver for Oracle supports the following versions of Oracle:

e Oracle Server: 21c, 19¢c, 18c, 12c, 11g, 10g, 9i, 8i, 8.0, including Oracle Express Edition of
18c, 11g, and 10g

¢ Oracle Client (x86 and x64 versions): 21c, 19c, 18¢c, 12c, 11g, 10g, 9i, 8i, 8.0; Oracle
Instant Client

¢ Oracle Cloud

Note: Support for the x64 version of Oracle Client is only available for 64-bit Windows.

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
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2.2 Features

Application

ODBC Interface o

TCP/IP

Driver Manager

Oracle

Devart ODBC driver
for Oracle

Direct Connection

Database applications based on our solution get an opportunity to establish connection to
Oracle by means of native Oracle client software and in Direct Mode. Direct Mode gives
your applications an unrivaled advantage - connection to Oracle databases directly via TCP/IP
avoiding Oracle Client. That improves performance of your applications, their quality, reliability
and especially the deployment process, since there is no need to supply additional client
software together with your application.

v ODBC API
ODBC Data -
Types

ODBC Conformance

Our ODBC driver provides full support for common ODBC interface:
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e ODBC Data Types support
e ODBC API Functions support

In addition, we provide support for Advanced Connection String parameters. Thus allowing
any desktop and web applications to connect to Oracle from various environments and
platforms, that support ODBC.

64

bit

32

bit

Development Platforms Variety

ODBC Driver for Oracle doesn't limit your choice of the development platform and
environment. The driver installations are available for various operational systems and
platforms. The current version supports Windows, macOS, Linux, both 32-bit and 64-bit. So
you can develop both 32-bit and 64-bit cross-platform applications.

]
] I

—

Database Compatibility

ODBC Driver for Oracle supports Oracle servers: 21c, 19c, 18c, 12c, 11g, 10g, 9i, 8i, 8.0,
including Oracle Express Edition 11g and 10g; as well as Oracle Cloud.

ODBC Diriver for Oracle supports both x86 and x64 versions of the following Oracle Clients:
21c, 19c, 18c, 12c¢, 11g, 10g, 9i, 8i, 8.0, Oracle Instant Client.

© 2024 Enter your company name
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2.3

Note that support for x64 versions of Oracle Clients is available for 64-bit Windows.

=2l

High Performance

All our products are designed to help you write high-performance, lightweight data access

layers, therefore they use advanced data access algorithms and techniques of optimization.

| v

Support

Visit our Support page to get instant help from knowledgeable and experienced professionals,
a quick resolution of your problems, and nightly builds with hotfixes.

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

Compatibility

Oracle Compatibility

ODBC Driver for Oracle supports the following database servers:

Oracle Clouds Support
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Oracle Cloud

<

Oracle Servers

7]
c
k]
T
o
+

21c

19c

18c (including Express Edition)

12c

11g (including Express Edition)

10g (including Express Edition)

9i

8i

CICIL LSS

8.0

Oracle Clients

(7]
c
k]
o
o
+

21c

19c

18c

12c

119

10g

9i

8i

8.0

Oracle Instant Client

CICIC LSS KK
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Supported Platforms

¢ Windows x86 and x64 (including Windows Terminal Server)
e macOS x64 and ARM (Apple Silicon M1)
e Linux x86 and x64

Compatibility with Third-Party Tools

Application Development Tools

1"

Adobe ColdFusion

Embarcadero Delphi & C++Builder
UniDAC, FireDAC, dbGo (ADO), BDE and dbExpress

FileMaker

Lazarus

Microsoft Visual FoxPro

Microsoft Visual Studio
Server Explorer and ADO.NET ODBC Provider

Omnis Studio

PHP

PowerBASIC

Python

CICOIC SO K

Database Management

Aqua Data Studio

dbForge Studio

dBeaver

EMS SQL Management Studio

CIC LK

© 2024 Enter your company name
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Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

SQL Server Reporting Services

CICOC LS

Bl & Analytics Software

Alteryx

DBxtra

Dundas Bl

IBM SPSS Statistics

MicroStrategy

Power Bl

Qlik Sense

QlikView

RStudio

SAP Crystal Reports

SAS JMP

Tableau

TARGIT

TIBCO Spotffire

CICIC SOOI

Office Software Suites

© 2024 Enter your company name
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24

2.5

LibreOffice
Microsoft Access
Microsoft Excel

OpenOffice

AR N SRR NN

StarOffice

© 2015-2024
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Requirements

The following requirements must be met for ODBC Driver for Oracle:

e [f you use the driver in the oct mode, Oracle Client must be available on your system.

* You can have only one version of ODBC Driver for Oracle installed on your system.

No additional client software is required in the pirect mode.

© 2015-2024
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Licensing

ODBC Driver License Agreement

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING
THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND
BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND
PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement") is a legal agreement between you
(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver
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software application, demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this Agreement, the
software program(s) and supporting documentation will be referred to as the "Software".

LICENSE
1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,
subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop
computer, provided it is accessed by no more than one person at a time, either directly or
remotely, for sole purposes only in accordance with this Agreement. If more than one person
can simultaneously use the computer where you plan to install the product, you must
purchase a Server License. A Desktop License is valid for one single desktop installation;

- the "Server Edition" allows you to install and use the Software on a single server, provided it
is accessed by more than one person at a time, either directly or remotely. This definition
includes, but is not limited to, Web servers, application servers, batch servers, and desktop
workstations, where more than one concurrent users can access the Software. A Server
License is valid for one single server installation, provided it is used by 1 (one) legal entity in
accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single
computer only during the subscription term specified at purchase. An Internet connection is
required to activate the license and check the license status when the Software is used.
Once the subscription term is over, you will be able to either stop using the Software or renew
the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version
on a single computer without an active subscription. A subscription provides access to new
product releases, regular upgrades, and support for new server versions provided during the
subscription term;

© 2024 Enter your company name
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- the "Site License" allows you to install and use the Software on one or more computers in a
single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in
a single company as well as deploy the Software as part of a licensee's application to web
servers, application servers, batch servers, desktops, and other end-user devices. This
definition includes the ability to install and use the application containing the Software without
any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the
hard disk of your computer and retain the original for archival purposes;

- develop and test Applications with the Software, subject to the Limitations below.
1.4. If you have the "OEM License", you are also entitled to:
- make any number of copies of the Software to deploy it to your end-user.

- deploy the Software to your end-user as a Software installation package or integrate it into
your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation
section.

No other rights or privileges are granted in this Agreement.
2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions
of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written
permission from Devart.

2.3. You may not distribute and sell any portion of the Software integrating it into your
Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the
Software license is non-transferable, and you may not transfer the Software installation
package.
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2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights
notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs
(Applications) created using the Software. You cannot distribute the Software integrated into
your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's
exclusive property.

4. TRANSFER

You may not transfer the Software to any individual or entity without express written
permission from Devart. In particular, you may not share copies of the Software under
"Desktop License" with other co-developers without obtaining proper license of these copies
for each individual; you may not install the Software under "Server License" on more than 1
(one) server without obtaining proper license of these installations for each server.

5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the
event of any failure to comply with any provision of this Agreement. Upon such termination
you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or
distribute Trial versions of the Software as an original installation package only. If the Software
you have obtained is marked as a "Trial" version, you may install and use the Software for a
period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the
additional restriction that it is used solely for evaluation of the Software and not in conjunction
with the development or deployment of any application in production. You may not use
Applications developed using Trial versions of the Software for any commercial purposes.
Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all
accompanying written materials must be destroyed.

7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart
makes no warranties, expressed or implied, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose or use.
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8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to
download improvements and enhancement from Devart's web site as they become available,
during the active subscription period. The initial subscription period is one year from the date
of purchase of the license. The subscription is automatically activated upon purchase, and
may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users
of the Software with an active subscription may request technical assistance with using the
Software over email from the Software development. Devart shall use its reasonable
endeavors to answer queries raised, but does not guarantee that your queries or problems
will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database
versions.

9. COPYRIGHT

The Software is confidential and proprietary copyrighted work of Devart and is protected by
international copyright laws and treaty provisions. You may not remove the copyright notice
from any copy of the Software or any copy of the written materials, accompanying the
Software.

This Agreement contains the total agreement between the two parties and supersedes any
other agreements, written, oral, expressed, or implied.
© 2015-2024
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26 Getting Support

This document lists several ways you can find help with using ODBC Driver for Oracle
describes the Priority Support program.

Support Options

There are a number of resources for finding help on installing and using ODBC Driver for
Oracle:

¢ You can find out more about ODBC Driver for Oracle installation or licensing by consulting
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Installation and License articles of this manual respectively.

* You can get community assistance and technical support on the Community Forum.

® You can get advanced technical assistance by ODBC Driver for Oracle developers through

the ODBC Driver for Oracle Priority Support program.

Subscriptions

The ODBC Diriver for Oracle Subscription program is an annual maintenance and support

service for ODBC Driver for Oracle users.

Users with a valid ODBC Driver for Oracle Subscription get the following benefits:
e Product support through the ODBC Driver for Oracle Priority Support program
e Access to new versions of ODBC Driver for Oracle when they are released

¢ Access to all ODBC Driver for Oracle updates and bug fixes

¢ Notifications about new product versions

Priority Support

ODBC Diriver for Oracle Priority Support is an advanced product support service for getting
expedited individual assistance with ODBC Driver for Oracle-related questions from the
ODBC Diriver for Oracle developers themselves. Priority Support is carried out over email and

has a two business day response policy. Priority Support is available for users with an active
ODBC Driver for Oracle Subscription.

To get help through the ODBC Driver for Oracle Priority Support program, please send an
email to odbc@devart.com describing the problem you are having. Make sure to include the

following information in your message:

Your ODBC Driver for Oracle Registration number.

e Full ODBC Driver for Oracle edition name and version number. You can find the version

number in DLL version information.
¢ Versions of the Oracle server and client you are using.
e A detailed problem description.

e |f possible, ODBC Administrator Log, scripts for creating and filling in database objects, and
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the application using ODBC Driver for Oracle.

If you have any questions regarding licensing or subscriptions, please see the FAQ or
contact sales@devart.com

© 2015-2024
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3 Using ODBC Driver
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3.1 Installation
ODBC Driver for Oracle currently supports the following platforms: Windows, macOS, and
Linux, both 32-bit and 64-bit.

See how to install Devart ODBC Driver for Oracle :

e \Windows

¢ \Windows Silent

e macOS

e Linux DEB
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e Linux RPM
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3.1.1  Windows

Installation

1. Download and run the installer.

2. Follow the instructions in the wizard.

i¥ setup - Devart ODBC Driver for Oracle — >

Welcome to the Devart ODBC Driver for
Oracle Setup Wizard

This will install Devart ODBC Driver for Orade 3. 1.2 on your
computer,

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

WARNIMG: This program is protected by copyright law and
international treaties.

ODBC Driver
for Oracle

3. In case if you already have the specified installation folder on the PC or another Driver
version is installed, you will get a warning. Click Yes to overwrite the old files with the
current installation, but it is recommended to completely uninstall the previous driver

version first, and then install the new one.
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4. On the Select Components page you can select whether to install the 64-bit version of the

driver or not. Clear the check box if you need no 64-bit installation. There is also a check

box on this page, that allows you to select whether to install Help and Manual.

i setup - Devart ODBC Driver for Oracle - x
Select Components
Which components should be installed? dewvark

Select the components you want to install; dear the components you do not want to
install, Clidk Mext when you are ready to continue,

Full installation e
Devart ODBC Driver for Qrade 6,1 MB
- [ Driver for Win32 2,6 MB
.. [] Driver for Wing4 3,6 MB
Help and Manual 3,9 MB

Current selection requires at least 16,7 MB of disk space.

5. In the License Information dialog box, you should select the license type and activate the
product. If you have no activation key, you can select Trial and use the driver for evaluation
purposes.

6. If you have an activation key, select the Activation Key option. Copy the activation key from
the registration email or your Customer Portal account and paste it into the Activation Key

edit box.
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i% setup - Devart ODBC Driver — >
License Information
Fleaze enter the path to the file containing the activation key received when devart

purchasing the product. If you have no activation key, select Trial Version.

() Trial
(®) Activation Key

u 1w FjNOD SMGAPOSgfMzjuY AEoDpy fgL¥mIX heuy Hadt S8M4F ZgxWheiBjxwr LS

7 15QYwWOUQOeY Tatef2NfkwL gB +HFAVeYghal 3nMhifdvYIriwFFwZNVIRh 2m4s ]
72EIxR 30F{9BLspR & ydbomx YUY mTAZ FHMQVXWPGQN 2UM 1Y 4odf3c3TTj IRAUAG 2d
eminjcTIIN4HEPxigTQRRGZBHKT 1L 3IAR 1/ f¥sIp/PiKknDSIbxVK +avkETuP

5Qw 1IKL 7hTw0dwStsheAtwPzLEaTi30CHY 3 +2MLSII3 =|

Load Activation Key ...

7. If you have the activation key file, click the Load Activation Key button and browse to it.

Activation — O X

= v « Do, * Activation v O Search Activat.. 2

= This PC Mame Date modified Type

. 30 Ohbj E activation 27.03.2020 13:52 KEY File
I Desktoj
|j Docurm
4 Downlo

D Music v < >

1 itemn

8. Click Next.
9. Click Install, then Finish.

10.After the installation is completed, you need to configure the driver.
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See also:

¢ |nstallation on macOS

¢ Install Linux DEB package

¢ |nstall Linux RPM package
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3.1.2 Windows Silent

Silent Installation with OEM license on Windows

1. Run the Command Prompt as an administrator.

2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCOracle.exe /SILENT /ActivationKey=ylc7nmgdu2341aszxcvONGurjfhxm9o0L
DevartODBCOracle.exe /VERYSILENT /ActivationKey=ekhdh765mh09ukr237gfHRtriTlwg
Note: The installation is performed by entering a license key.

DevartODBCOracle.exe /SILENT /ActivationFile=d:\Tlic.key

DevartODBCOracle.exe /VERYSILENT /ActivationFile=d:\1lic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is
required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation
process is performed without user interference.

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

3.1.3 macOS

Prerequisites
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ODBC Diriver for Oracle works under control of an ODBC driver manager. ODBC driver
manager is not distributed along with our driver and must be installed separately.

ODBC Diriver for Oracle is compatible with iODBC driver manager.

In case when using other ODBC driver managers, ODBC Driver for Oracle will be installed,
but it will require manual modification of configuration files of these managers.

Installing ODBC Driver for Oracle
1. Go to Security & Privacy settings in the System Preferences.

2. Enable the App Store and identified developers option in the Allows apps downloaded

from section.
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[ ] 4 G Security & Privacy Q

m FileVault = Firewall  Privacy

A login password has been set for this user Change Password...

Require password 5 minutes B after sleep or screen saver begins
Show a message when the screen is locked

Disable automatic login

Use your Apple Watch to unlock apps and your Mac

Allow apps downloaded from:

) App Store
° App Store and identified developers

o’
Eﬁ Click the lock to prevent further changes. Advanced... ?

Note: If the options in Allow apps downloaded from section are grayed out, click on the

lock icon and enter your administrator password to proceed with the installation.

3. Download the PKG file from the Devart website.

4. Run the downloaded file, press the Allow button to proceed with the installation.
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® O ‘= Install Devart ODBC Driver for Oracle ]

Welcome to the Devart ODBC Driver for Oracle Installer

This will install Devart ODBC Driver for Oracle 2.5.1 on your

@ Introduction computer.
Read Me WARNING: This program is protected by copyright law and international
} treaties
License

Registration
Destination Select
Installation Type
Installation

Summary

Continue

5. After reading the license agreement, click Agree.
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w Install Devart ODBC Driver [

To continue installing the software you must agree to the terms of
the software license agreement.

g Click Agree to continue or click Disagree to cancel the installation and
Rei guit the Installer.
o Lic
Re MS
! Read License Disagree Agree
De|

Installation Type
INTRODUCTION

Installation

§ This Devart end-user license agreement ("Agreement”) is a legal

Summary agreement between you (either an individual person or a single legal
entity) and Devart, for the use of the ODBC Driver software application,
demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this
Agreement, the software program(s) and supporting documentation will
be referred to as the "Software”.

LICENSE

Print... Save... Go Back Continue

6. In the License Information dialog box, you should select the license type and activate the
product. If you have no activation key, you can select Trial and use the driver for evaluation
purposes.

7. If you have an activation key, select the Activation Key option. Copy the activation key from
the registration email or your Customer Portal account and paste it into the Activation Key

edit box.
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@®C

@ Introduction
© Read Me

© License

© Registration

Destination Select
Installation Type
Installation

Summary

‘& Install Devart ODBC Driver s
Registration

License information
Please enter the path to the file containing the activation key
received when purchasing the preduct. If you have no
activation key, select Trial Version.

I Trial
°' Activation Key

d1asbaFDhafkésHdrnfbvwncnve TR4i11+GDVFC465furdxawBMNYCru
bbv3546ifa6a7litkbbhuvDFaHre2965+gvefxixtrd23nmbCVBrut!/
q1f2b7==chhfvritviXcvRfyurkawRThabvyvuTrwo09/65ii TRABMNNYVCrb
b4 56T Kiiguuvbh

Load Activation Key ...

Go Back Continue

8. If you have the activation key file, click the Load Activation Key button and browse to it.
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[ NON | [l Desktop
4 = [0 o1 == | #~ 0 a Q. Search

Favorites

@ AirDrop A

&Y iCloud Drive A . CTHT |
& All My Files test
pé\; Applications

=] Desktop

@ Documents

0 Downloads

Devices
Remote Disc

Shared
server

@ Al
T m——

[

9. To complete the installation click Continue, then Install buttons.
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314

O & Install Devart ODBC Driver fa)
The installation was completed successfully.
Introduction
Read Me
License
Registration
3 0 - -
Destirstion Sekoat The installation was successful.
bl bl The software was installed.
Installation
Summary

To activate the driver, perform the steps described in the Product Activation article.

See also:

¢ |nstallation on Windows

¢ |nstall Linux DEB package

¢ Install Linux RPM package
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Linux DEB

Prerequisites

Provide Feedback
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ODBC Diriver for Oracle works under control of an ODBC driver manager. ODBC driver
manager is not distributed along with our driver and must be installed separately.

ODBC Diriver for Oracle is compatible with UnixODBC driver manager. You can install the

unixODBC driver manager using the command below:

sudo apt-get install odbcinstldebian2 libodbcl odbcinst unixodbc

In case when using other ODBC driver managers, ODBC Driver for Oracle will be installed,
but it will require manual modification of configuration files of these managers.

Installation

Let's consider how to install the Devart ODBC driver on Linux from a DEB package, for
example, on Ubuntu. There are two ways to install the driver either manually or via the
command line.

GUI installation
1. Download the DEB package of the required bitness from the Devart website.

2. Navigate to the folder with the downloaded package ("Downloads" by default) and double-
click it.

3. In the opened dialog, click the Install button.
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Ubuntu Software

devartodbcoracle

devartodbcoracle
New level of Functionality and performance in data access via ODBC

Install

Devart ODBC Driver for Oracle provides a high-performance and feature-rich connectivity solution fFor ODBC-
based applications to access Oracle databases from Windows, macOS, Linux, both 32-bit and 64-bit. Full
suppork for standard ODBC API functions and data types implemented in our driver makes interaction of your
database applications with Oracle fast, easy and extremely handy.

Website

Details

Version 3.0.1
Source Unknown
Size 3,8MB

Coon-free 38 3rd party |

This software comes from a 3rd party and may contain non-free components.

4. If the installation is successfully completed, the Install button changes into the Remove

one.

Command-line installation
1. Download the DEB package from the Devart website.

By default the required package will be downloaded into the ~/Downloads folder (or the

selected one);

2. Run the 'Terminal' program;

3. Navigate to the folder with the downloaded package cd ~/Downloads (if you downloaded
the package into another folder, you need to specify the path to this folder as the cd

command parameter):
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cd ~/Downloads/

test@ubuntu:~% cd ~/Downloads/
test@ubuntu:~/Downloads$ [

4. To install the devartodbcoracle_i386.deb on a 32-bit system, use the following command:

sudo dpkg -1 devartodbcoracle_1386.deb

test@ubuntu:~$ cd ~/Downloads/f
test@ubuntu:~/DownloadsS$ sudo dpkg -1 devartodbcoracle i386.deb [

5. To install the devartodbcoracle_amd64.deb on a 64-bit system, use the following

command:

sudo dpkg -i devartodbcoracle_amd64.deb

test@ubuntu:~% cd ~/Downloads/
test@ubuntu:~/Downloads$ sudo dpkg -i devartodbcoracle amd64.deb]j

6. Driver is installed successfully.

test@ubuntu:~/Downloads$ sudo dpkg -i devartodbcpostgresql i386.deb
(Reading database ... 238056 Tiles and directories currently installed.)
Preparing to unpack devartodbcpostgresql i386.deb ...

Unpacking devartodbcpostgresgl (3.0.1) over (2.5.1)
Setting up devartodbcpostgresql (3.68.1)
test@ubuntu:~/Downloadss

To activate the driver, perform the steps described in the Product Activation article.

See also:
e |nstall Linux RPM package

¢ |nstallation on Windows
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¢ |nstallation on macOS
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Linux RPM

Prerequisites

ODBC Diriver for Oracle works under control of an ODBC driver manager. ODBC driver

manager is not distributed along with our driver and must be installed separately.
ODBC Driver for Oracle is compatible with UnixODBC driver manager.

In case when using other ODBC driver managers, ODBC Driver for Oracle will be installed,
but it will require manual modification of configuration files of these managers.

Installation

Let's consider how to install the Devart ODBC driver on Linux from an RPM package, for
example, on CentOS. To install the driver, you should download the .rpm package and install
it via the command line. See the detailed description of these steps below:

1. Download the RPM package from the Devart website.

By default the required package will be downloaded into the ~/Downloads folder (or the
selected one);

2. Run the 'Konsole' program;

3. Navigate to the folder with the downloaded package cd ~/Downloads (if you downloaded
the package into another folder, you need to specify the path to this folder as the cd

command parameter):

cd ~/Downloads/
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4. To install the devart-odbc-oracle.i386.rpm on a 32-bit system, use the following command::

sudo rpm -ivh devart-odbc-oracle.i386.rpm

[test@localhost ~]% sudo rpm -ivh devart-odbc-oracle.i386.rpm

To install the devart-odbc-oracle.x86_64.rpm on a 64-bit system, use the following

command::

sudo rpm -ivh devart-odbc-oracle.x86_64.rpm

rpm -ivh devart-odbc-oracle.xss 64.rpm I

To activate the driver, perform the steps described in the Product Activation article.

See also:
e |nstall Linux DEB package

¢ |nstallation on Windows

¢ |nstallation on macOS
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3.2 Product Activation

See how to activate Devart ODBC Driver for Oracle :

e Obtaining Activation Key

e Activation on Windows

e Activation on macOS

e Activation on Linux

¢ Where to see the license information

© 2015-2024
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3.21 Obtaining Activation Key

To obtain a product activation key, follow these instructions:
1. After purchasing the license, you receive a registration email to the email address,

specified when ordering the product.

2. This email contains a Driver Activation Key and Login Credentials for the Customer Portal.

Keep this information secret.

3. You can copy the Activation Key either from the registration email or at the Customer Portal
account.

4. To login to the Customer Portal, use your Username and Password from the registration
email.

5. To obtain your Activation Key, click the View link on the right. You will get the following

dialog box:
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Activation Key

ulwTiCODBNGAEDFghMNzjuTAToDjwgLNmX Meuy+kt2YisW39cp39ih89)Z6mCh
MhlQfsILhFIgrh QWX TEmuz 1)i+IQycFEPkmX+Z5Y QP XtTebxgMUSHsUdPNsKis
93Ee03mgHGadwIIHSQXuKKBzPIxDI8 1io5ffSvmpp|LEEXvIaOkPRh4araaudUiK
rodrz GOxukSjdOMNfxzeykQ==

COPY TO CLIPBOARD CLOSE

6. Copy the Activation Key with the Copy to Clipboard button.

See also:

e Activation on Windows

e Activation on macOS

e Activation on Linux
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3.2.2 Activation on Windows

Driver Activation After Installation

To activate your installed driver using ODBC Administrator, perform the following steps:
1. Run ODBC Administrator.

i&'

Data Sources
(QDBC)

2. In the System DSN tab click the Add button.
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E ODBC Data Source Administrator (4-bit) >

User DSM  System DSN  File DSN  Drivers  Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver 2 Add...
QODBC Driver for Azure_x32 32bit Devart ODBC Driverfor SGL S

QODBC Driver for BigCommerce_x32 32-bit Devart QDBC Driver for BigCor Remaove
QDBC Driver for Dynamics_32 32bit Devart QDBC Driver far Dynam

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebir: Configure...

QDBC Driver for Magento_x32 32bit Devart QDBC Driver for Mager
QODBC Driver for MailChimp_x32 32bit Devart QDBC Driver far MailCh
QDBC Driver for MangoDB Gd-bit Devart QDBC Driver far Mongao
QDBC Driver for MangoDB_x32 32bit Devart QDBC Driver far Mongao

QDBC Driver for MySQL 32bit 32hit Devart ODBC Driver for MySQI ¥
£ >

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

B

Cancel Apply Help

3. In the appeared dialog box, select the installed driver, click Finish.
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Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel

39

4. In the Driver Configuration dialog box, on the License tab, click the Input Activation Key

button.
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| General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . 0K Cancel

5. Copy the activation key from the registration email carefully and paste it into the Input

Activation Key edit box.

Input Activation Key

Activation Key:

U 1w FRODEBGAEIFgbMZUTAToG v faLMmIX fheuy HdSpWCSKTE +d 2ZIwrmnI +A4A
u lw FCODENGAEDIFgbNzZiuTg ToD v /gLMmIX heuy Hel 5 IN4ZZgxWh 2MiXwr IS
A7E 103mgH6a 5w 1S fSQXuKKSzPIxDIS 1to 5 5vmppiL3EXvIaOkPRh4araausUf
a9BZh4ERVELA /pR IHWLZSXZ8k00 12Cx FaGy v 1¥hiknLRK 2L sbLMLP&mbxBC 2gn
WEZSMMErH72950xNiFvtZ IFnMsC 7 4scOuigWQsRed s =

Load Key...

Cancel

6. If you have the activation key file, click the Load Key button and browse to it.
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7. Click OK.
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3.2.3 Activation on macOS

Driver Activation After Installation

If you don’t activate your driver during installation, you can activate it later by following the
steps:

1. Create a file with the "activation.key" name.

2. Copy the activation key from the registration email or your Customer Portal account and
paste it into the created file.

3. Place the "activation.key" file into the folder where the driver was installed (for Devart

ODBC Driver for Oracle it is /Library/ODBC/Devart/Oracle by default).

See also:

e Activation on Windows

e Activation on Linux
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3.2.4 Activation on Linux

Driver Activation After Installation

If you did not activate the driver during installation, you can activate it later:

1. Create a file with the "activation.key" name.

2. Copy the activation key from the registration email or your Customer Portal account and

paste it into the created file.

3. Place the "activation.key" file into the folder where the driver was installed:
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- for the DEB package of Devart ODBC Driver for Oracle, it is /usr/share/devart/odbcoracle
by default;

- for the RPM package of Devart ODBC Driver for Oracle, it is /usr/local/devart/odbcoracle by
default.

See also:

e Activation on Windows

e Activation on macOS
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3.2.5 Where to See the License Information?

To see the license information of your installed driver, do the following:
1. In the Control Panel run ODBC Administrator

Data Sources

(ODBC)

2. Open the System DSN tab and click the Add button
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System Data Sources:

E ODBC Data Source Administrator (4-bit)

Mame

QODBC Driver for Azure_x32

QODBC Driver for BigCommerce_x32
QDBC Driver for Dynamics_32
QDBC Driver for Firebird_x32
QDBC Driver for Magento_x32
QODBC Driver for MailChimp_x32
QDBC Driver for MangoDB

QDBC Driver for MangoDB_x32

QDBC Driver for MySQL 32bit
£

Platfarm
32-bit
32-bit
32-bit
32-bit
32-bit
32-bit
G4-bit
32-bit
32-bit

Diriver

Devart QDBC Driverfor SAL 5
Devart QDBC Driver for BigCor
Devart QDBC Driver far Dynam
Devart QDBC Driver for Firebirc
Devart QDBC Driver for Mager
Devart QDBC Driver for MailCh
Devart QDBC Driver far Mongao
Devart QDBC Driver far Mongao

Devart ODBC Driver for MySQI ¥
>

B

Cancel

User DSM  System DSN  File DSN  Drivers  Tracing Connection Pooling  About

Add...

Remove

Configure...

Apply

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

Help

3. Select the driver and click Finish
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Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel

4. In the appeared dialogue, select the License tab
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General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . Ok Cancel

See also
e Product Activation
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3.3 Connecting to Oracle

See how to connect the Devart ODBC Driver for ODBC Driver for Oracle:
¢ \Windows DSN Configuration

e macOS DSN Configuration

¢ Linux DSN Configuration
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3.341

Windows

Windows DSN Configuration
After installing the driver, create a DSN for Oracle in the ODBC Data Source Administrator.
1. Open the ODBC Data Source Administrator.

e Type opBC Data Sources in the Windows search box and choose the application that
matches the bitness of the third-party application (32-bit or 64-bit). You can also open
ODBC Data Sources from Control Panel > Administrative Tools. Note that before
Windows 8, the icon was named Data Sources (ODBC).

e Alternatively, you can run c:\Windows\SysWoW64\odbcad32.exe to create a 32-bit DSN or c:
\Windows\System32\odbcad32.exe t0O create a 64-bit DSN.

2. Select the User DSN or System DSN tab. Most applications work with both types, yet
some applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog will appear.

4. Select Devart ODBC Driver for ODBC Driver for Oracle and click Finish. The driver
setup dialog will open.

5. Enter the connection information in the appropriate fields.
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Devart ODBC Driver for Oracle Configuration
__________________ . Advanced Settings  Security Settings  License  About

Data Source Name |DE'u'EFt ODEC for Orade |
Description |DDBC Driver |
Home Mame |DE1'auIt [CraClient11g_home1] e |
Server 127.0.0.1 v|
User ID |5cntt |

Fassword |"-" | Save Password
Connect Mode Mormal w

[ Joirect
Use 51D
Test Connection Cancel

6. You may test the connectivity by clicking Test Connection.

7. Click OK to save the DSN.

See Also

Connection Options

© 2015-2024
Devart. All Rights
Reserved.

3.3.2 Mac

Request Support ODBC Forum

macOS DSN Configuration

Provide Feedback
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After the driver is installed, DSN with the name DEVART_ORACLE is created. You can use it
to test a connection with ORACLE server. For this, perform the following steps:

1. Run the iODBC utility of the required bitness. Find the DEVART_ORACLE section and

click the Configure button:

] iODBC Data Source Administrator (64-Bit Edition)

User DSN File DSN ODBC Drivers Connection Pooling Tracing About

System Data Sources

Name Description Driver Add
DEVART_ASE - Devart ODBC Driver for ASE

DEVART_FIREBIRD - Devart ODBC Driver for Firebird Remava
DEVART_INTERBASE - Devart ODBC Driver for InterBase Configure
DEVART_MONGODB - Devart ODBC Driver for MongoDB, —
DEVART_MYSQL - Devart ODBC Driver for MySQL
DEVART_ORACLE Devart ODBC Driver for Oracle
DEVART_POSTGRESQL - Devart ODBC Driver for PostgreSC Test
DEVART_REDSHIFT - Devart ODBC Driver for Amazen R
DEVART_SQLAZURE - Devart ODBC Driver for SAL Azure
DEVART_SQLITE - Devart ODBC Driver for SQLite

DEVART SQLSERVER

Devart ODBC Driver for SQL Serve

_ System Data Source Mames create systems-wide CDBC Data Names that resolve to Data
! Source connection information.

Cancel
-

2. In the appeared dialog, specify the required connection settings and click OK.
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@O Setup of DEVART_ORACLE
Data Source Name (DSN)  DEVART ORACLE
Comment

Keyword Value
Direct True
Host oracle
Port 1521
Service Name localhost
User D Scott
Password Rk

+ -

3. Now click the Test button to establish a test connection to your data source.

49
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@ iODBC Data Source Administrator (64-Bit Edition)

User DSN File DSN ODBC Drivers Connection Pooling Tracing About

System Data Sources

Name Description Driver Add
DEVART_ASE - Devart ODBC Driver for ASE

DEVART_FIREBIRD - Devart ODBC Driver for Firebird Remova
DEVART_INTERBASE - Devart ODBC Driver for InterBase Configure
DEVART_MONGODB - Devart ODBC Driver for MongeDB), ———
DEVART_MYSQL - Devart ODBC Driver for MySQL
DEVART_ORACLE Devart ODBC Driver for Oracle
DEVART_POSTGRESQL - Devart ODBC Driver for PostgreSG Test
DEVART_REDSHIFT - Devart ODBC Driver for Amazon R
DEVART_SQLAZURE - Devart ODBC Driver for SQL Azure
DEVART_SQLITE - Devart ODBC Driver for SQLite

DEVART SQLSERVER

Devart ODBC Driver for SOL Serve

_____ System Data Source Names create systems-wide ODBC Data Mames that resolve to Data
E Source connection information.

See Also
Connection Options

© 2015-2024
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3.3.3 Linux

Linux DSN Configuration

After the linux (DEB or RPM) driver is installed, a DSN with the name DEVART_ORACLE is
created. You can use it to test the connection with the ORACLE server. For this, perform the

following steps:
1. Open the odbc.ini file located in the /etc folder. Find the DEVART_ORACLE section and

specify the required connection settings:

© 2024 Enter your company name


https://www.devart.com/company/contactform.html?category=0&product=odbc/oracle
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/oracle/feedback.html
https://www.devart.com/odbc/oracle/

Using ODBC Driver 51

User ID=<your Oracle User Name>
Password=<your Oracle password>
Host=<your Oracle Server Name>
Port=<your Oracle Listener Port>
Database=<your Oracle database name>

2. Run the UnixODBC Test Command utility and test a connection using the following

command:

isql -v DEVART_ORACLE

test@ubuntu:~$ isql -v DEVART_ORACLE

Connected!

sql-statement
help [tablename]

See Also
Connection Options

© 2015-2024
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3.4 Connection String Parameters

Oracle ODBC Connection String Parameters

The following table lists the connection string parameters for Oracle.
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Paramet

Description
er
Direct Enables the Direct mode.
Home Used to select the Oracle client to use with the application.
Host Used to specify the host of the data source.

Password |Used to specify the password.

Port Used to specify the port number for the connection. 1521 by default.
Used to change the current schema of the session to the specified

—— schema.

Server Used to specify the server name.

Service Used to specify the name of the Oracle Client. The value may be selected

Name from the drop-down list of available clients.

SID Used to specify the Oracle system identifier of the database instance.

User ID Used to specify the username.

Advanced Settings

Enables the use of all schemas that an Oracle user has been granted
AllSchemas | _
privileges on. The default value is False.

Allow NULL

strings

To retrieve metadata, not all parameters according to MSDN can accept a

null value. If NULL, the driver should return an error. But some 3rd-party

Empt
p.y tools pass NULL to the parameters. These options should be enabled for
strings as

T compatibility with such tools.

Character |Used to setthe character set that the driver uses to read and write

Set character data.

Used to specify the system privilege for the user who connects to the
server. The privilege must be granted to the user before connecting to the
server.

ConneCtMOdeNormal

The default value. Connect as a normal user.
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SysOper

Connect with the SYSOPER privilege.
SysDBA

Connect with the SYSDBA privilege.
SysASM

Connect with the SYSASM privilege.
SysBkp

Connect with the SysBackup privilege.
SysDG

Connect with the SysDG privilege.
SyskM

Connect with the SYSKM privilege.

The time (in seconds) to wait for a connection to open before terminating

Connection _ _
) an attempt. The default value is 0 — an attempt to connect waits
Timeout
indefinitely.
e Default - The default value. The driver maps the Oracle DATE data type
to the ODBC data type SQL_TYPE_TIMESTAMP.
Date Type

® Date Only - The driver maps the Oracle DATE data type to the ODBC
data type SQL_TYPE_DATE.

The Internet Protocol Version.
ivIPv4

The default value. Internet Protocol Version 4 (IPv4) is used.
ivIPv6

Internet Protocol Version 6 (IPv6) is used.
IP Version |ivIPBoth

Either Internet Protocol Version 6 (IPv6) or Version 4 (IPv4) is used.
Note: When the property is set to ivIPBoth, a connection attempt is made
via IPve6 if itis enabled in the operating system. If the connection attempt

fails, a new connection attempt is made via IPv4.
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MinFetchRow

S

ODBC

Behavior

ReadOnly

Respectively, if the SQL_ATTR_ROW_ARRAY_SIZE attribute value is

less than MinFetchRows, then the number of rows queried from the server

will equal MinFetchRows. Otherwise - it will be equal to

SQL_ATTR_ROW_ARRAY SIZE.

In order to make the driver to query from the server exactly the same
number of rows as specified inthe SQL_ATTR_ROW_ARRAY_SIZE

attribute, it is enough to set the MinFetchRows parameter to 0. However,

in this case, you should take into account, that the

SQL_ATTR_ROW_ARRAY_SIZE value is 1 by default, and therefore

performance decreases dramatically at this value.

Used to set the behavior corresponding to the ODBC specification

version that a third-party tool expects. The behavior of ODBC driver can
be changed by setting a value for the SQL_ATTR_ODBC_VERSION
attribute by calling the SQLSetEnvAttr function. But some third-party tools

expect the driver to exhibit ODBC 2.x behavior, but forget to call

SQLSetEnvAttr with the specified version or pass an incorrect value there.

In this case, the required behavior can be explicitly specified in the

Connection String by setting the ODBC Behavior parameter. The possible

values are:

® Default - default ODBC behavior determined by a third-party tool.

* Ver 2.x- ODBC 2.x behavior is explicitly set.
* Ver 3.x- ODBC 3.x behavior is explicitly set.

Used to prevent data from being modified, if set to True. False by default.

RegionalNum Enables the use of local regional settings when converting numbers to

berSettings

RegionalDat

gs

strings.

Enables the use of local regional settings when converting dates and
eTimeSettin|

times to a strings.
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Sets the string value types returned by the driver as Default, Ansi or

Unicode.

* Default - the driver defines the string types.

* Ansi - all string types will be returned as SQL_CHAR, SQL_VARCHAR

String and SQL_LONGVARCHAR.

Types
® Unicode - all string types will be returned as SQL_WCHAR,

SQL_WVARCHAR and SQL_WLONGVARCHAR.
The parameter value should be changed if any third-party tool supports
only Ansi string types or Unicode ones.

Use Unicode Enables Unicode support.

Sample Oracle ODBC Connection String in Direct Mode

Using Service Name:

DRIVER={Devart ODBC Driver for
Oracle};Direct=True;Host=myServer;Service Name=myServiceName;User
ID=myUsername;Password=myPassword

Using SID (deprecated format):

DRIVER={Devart ODBC Driver for
Ooracle};Direct=True;Host=myServer;SID=mySID;User
ID=myUsername;Password=myPassword

Sample Oracle ODBC Connection String in OCI Mode

DRIVER={Devart ODBC Driver for Oracle};Data Source=myServer/
myServiceName;Home Name=myHomeName;uUser
ID=myUsername;Password=myPassword

See also:
e SSL Connection
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3.5

3.51

e SSH Connection

e HTTP Tunneling

© 2015-2024
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Secure Connections

This section describes how to establish secure connections to Oracle with ODBC Driver for
Oracle.

e SSL Connection

e SSH Connection

e HTTP Tunneling

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

SSL Connection

Connecting to Oracle Using SSL

SSL (Secure Sockets Layer) is a standard protocol for secure access to a remote machine
over untrusted networks. It runs on top of TCP/IP to secure client-server communications by
allowing an SSL-enabled client to authenticate itself to an SSL-enabled server and vice versa.
During server authentication, an SSL-enabled client application uses standard techniques of
public-key cryptography to verify the server's identity by checking that the server's certificate
is issued by a trusted certificate authority (CA) and proves the ownership of the public key.

Conversely, SSL client authentication allows the server to validate the client's identity. The
client and server can also authenticate each other using self-signed certificates, however, you
will almost never want to use a self-signed certificate, except for an Intranet or a development
server. After establishing an SSL connection, the client and server can exchange messages
that are symmetrically encrypted with the shared secret key. SSL is the recommended
method to establish a secure connection to Oracle due to easier configuration and higher
performance, compared to SSH.

Connecting to Oracle Using Wallet Path
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A wallet is container for storing authentication and signing credentials, including keys and
certificates needed by SSL. To establish an SSL connection to Oracle Database using a
wallet file, specify the path to the wallet in the wallet Path field. See the Oracle documentation
for information on creating an Oracle wallet. If you are using Oracle Cloud, see this document
for information on obtaining a wallet.

Devart ODBC Driver for Cracle Configuration pod
General Advanced Settings Security Settings  License  About

55L Options 554 Options  HTTP and HTTPS Options

Use 55L

Wallet Path |C:‘|,v:|r-.'allet. 850

Wallet Reqistry |

Certificate |

Key |

|
|
CA Certificate | |
|
|
|

Server Certificate DM |C=U5,D =Devart, OU=Devarts5L,CMN =TE5tSSL|

Ignore Server Certificate Validity
Ignore Server Certificate Constraints
[ Trust Server Certificate

|:| Ignore Server Certificate Insecurity

Test Connection - Cancel

Connecting to Oracle Using Oracle Wallet (Registry)

To establish an SSL connection to Oracle Database using a wallet that is stored in the
Windows registry, specify the registry key in the wallet path field. See this document for
information on storing a wallet in the registry.
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Devart ODBC Driver for Oracle Configuration
General Advanced Settings Security Settings  License  About

55L Options | 554 Options  HTTP and HTTPS Options

Use 55L

Wallet Path | |

Wallet Reqistry |\,‘IJ-II{EY_CUF'.RENT_USEREnftwarE\,DradE‘n,'Lﬁrallf|

CA Certificate | |

Certificate | |

Key | |

Server Certificate DM |C=U5,D=Devart,DU=Deuart55L;CN =TESt55L| |

Ignore Server Certificate Validity
Ignore Server Certificate Constraints
[ ] Trust Server Certificate

|:| Ignore Server Certificate Insecurity

Test Connection - Cancel

Connecting to Oracle Using SSL Certificates and Keys

To establish an SSL connection to Oracle Database using certificates and keys, specify the
CA certificate, client certificate, and private client key in the cA certificate, Certificate, and

key fields, respectively.
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Devart ODBC Driver for Oracle Configuration ot
General Advanced Settings Security Settings  License  About
55L Opfions 554 Options  HTTP and HTTPS Options
Use 55L
Walet Path | |
Wallet Reqistry | |
CA Certificate |C: \ca.pem |
Certificate |C: Ydlient.pem |
kKey |C: Yelient. key |
Server Certificate DM |C=LI5,0 =Devart, OU=Devart55L,CN=Test55L |
Ignore Server Certificate Validity
Ignore Server Certificate Constraints
[ Trust Server Certificate
|:| Ignore Server Certificate Insecurity
Test Connection i Cancel
SSL Options
Option Description
Use SSL Enables SSL connections.

Wallet Path
Wallet Registry
SSL CA Certificate

SSL Certificate

SSL Key

Server Certificate DN

The directory where the wallet is stored.
The registry key where the wallet is stored.
The CA certificate.

The client certificate.

The private client key.

The server's distinguished name (DN) to
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Ignore Server Certificate Validity

Ignore Server Certificate Constraints

Trust Server Certificate

Ignore Server Certificate Insecurity

enable server DN matching. It checks
whether the server is genuine by matching
the server's global database name against
the DN from the server certificate.
Specifies whether to check the server
certificate validity period during an SSL

handshake. The default value is True.

Specifies whether to verify the server
certificate for compliance with constraints
during an SSL handshake. The default

value is True.

Specifies whether to verify the server
certificate during an SSL handshake. By
default, the driver verifies the server
certificate. When the option is setto True,
the driver will bypass walking the certificate
chain to verify the certificate.

Specifes whether to check the server
certificate signature security during an SSL

handshake. The default value is False.

Sample Connection String Using Oracle Wallet (Path)

DRIVER={Devart ODBC Driver for Oracle};Direct=True;Host=tcps://
myHost;Service Name=myServiceName;User
ID=myUsername;Password=myPassword;Use SSL=True;wallet

Path=mywallet.sso

Sample SSL Connection String Using Oracle Wallet (Registry)

DRIVER={Devart ODBC Driver for Oracle};Direct=True;Host=tcps://
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3.5.2

myHost;Service Name=myServiceName;User
ID=myUsername;Password=myPassword;Use SSL=True;wallet Registry=\
\HKEY_CURRENT_USER\Software\Oracle\wallets\Keyl\mywallet.sso

Sample Connection String Using SSL Certificates and Keys

DRIVER={Devart ODBC Driver for Oracle};Direct=True;Host=tcps://
myHost;Service Name=myServiceName;User
ID=myUsername;Password=myPassword;Use SSL=True;SSL CA Cert=C:
\myCaCertificate.pem;SSL Cert=C:\myClientCertificate.pem;SSL
Key=C:\myPrivateClient\myKey.pem

© 2015-2024
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SSH Connection

Connecting to Oracle Using SSH

This section discusses how to connect to Oracle through SSH. Secure Shell (SSH) is
cryptographic network protocol for secure remote login, command execution and file transfer
over untrusted networks. SSH uses client-server architecture, connecting an SSH client with
an SSH server. The client and server authenticate each other and pass commands and
output back and forth. To secure the transmitted data, SSH employs forms of symmetric

encryption, assymetric encryption, and hashing.

In symmetric key cryptography, a single key is used by the sending and receiving parties to
encrypt and decrypt messages. Assymetric encryption requires two associated keys, the
private key and the public key. The public key encrypts messages that can only be decrypted
by the private key. The public can key can be freely shared with anyone to autenticate another
party, while the private key must be kept secret. The client public key must be stored in a
location that is accessible by the SSH server to authenticate the server by the client;
conversely, the server public key must be placed on the client side to authenticate the client
by the server. Assymetrical encryption is used during the initial key exchange process to
produce the shared secret (session key) to encrypt messages for the duration of the session.

The SSH server listens on default port 22 (this port can be changed) for incoming TCP
connections. The SSH client begins the initial TCP handshake with the server and verifies the
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server's identity. The client and server agree upon the encryption protocol and negotiate a
session key. The server then authenticates the client and spawns the right environment. The
ODBC driver for Oracle implements the SSH client feature to connect to the SSH server on

the remote machine at the specified port. The SSH server authenticates the client and
enables the driver to establish a secure direct connection to Oracle. Below is a simplified
diagram representing the SSH tunneling.

Devart ODBEC Untrusted

Driver Network SSH Server DB Server

-
v
E
B
F 9
v

Note: You don't have to install the SSH client since ODBC Driver for Oracle implements the
SSH client functionality.
If you're connecting.to Oracle Cloud, you can use the default username.ops.and leave the

password and server key empty.

SSH Connection Options

To establish an SSH connection to Oracle, specify the connection parameters on the ssH

Options tab under security Settings.
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Devart QOBC Criver for Oracle Configuration X
General Advanced Settings Security Settings  License  About
SSL Options  55H Opfions  HTTP and HTTPS Options
[1ise SSH:
Host Name |192.168.50. 162 |
Port |22 |
User MName |SSHLIser |
F'ﬂSS'.l’l,'EIFIj |"-"."-" |
Client Private Key |private_dient_key.pem |
Password for Key |iiliiiiiliiii |
Server Public Key |pub|ic_server_key.pem |
Storage Path |D: Feys) |
Test Connection - Cancel
SSH Connection Options:
Option Description
Use SSH Enables SSH connections.

SSH Host name

SSH Port

SSH User Name

The host name or IP address of the SSH
server.

The SSH port number (22 by default).
The username for the account on the SSH
server. For Oracle Cloud, you can use the

default user, ops.
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3.5.3

The password for the account on the SSH
SSH Password server. If you use the default user, ops in
Oracle Cloud, leave the option empty.

. The filename of the client private key for
SSH Client Key
key-based authentication.

SSH Client Key Password The passphrase for the client private key.

The filename of the SSH server public key.
SSH Server Key
For Oracle Cloud, leave the option empty.

The directory where the encryption keys are
SSH Storage Path
stored.

Sample Connection String:

DRIVER=Devart ODBC Driver for
Oracle;Direct=True;Host=myHost;Service Name=myServiceName;User
ID=myUsername;Password=myPassword;Use SSH=True;SSH Host
name=mySshHost;SSH User Name=mySshUsername;SSH
Password=mySshPassword;SSH Client Key=myPrivateClientKey.pem;SSH
Client Key Password=myClientKeyPassphrase;SSH Server
Key=myPublicServerKey.pem;SSH Storage Path=myDirectorywithKeys
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HTTP Tunneling

Connecting to Oracle Using HTTP Tunneling

This section discusses how to connect the ODBC driver to Oracle through an HTTP tunnel. If
you need to connect to Oracle in conditions of restricted connectivity, e.g. when a database
server is hidden behind a firewall, or you need to transmit private network data through a
public network, you can set up an HTTP tunnel to create a direct network link between two
locations. The tunnel is created by an intermediary called a proxy server.

When Oracle server is hidden behind a firewall, the client is not able to connect to the server
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directly on a specified port. If the firewall allows HTTP connections, you can use the ODBC
driver with a properly configured web server to connect to the database server. The driver
supports HTTP tunneling based on the PHP script.

A possible scenario of using HTTP tunneling: the client needs to access the database of a
website from a remote machine, but access to the designated port of the database server is
forbidden — only connections on the HTTP port 80 are allowed. To establish a connection in
this situation, you must deploy the tunnel.php script, which is distributed with the driver, on
the web server. It enables access to the database server through an HTTP tunnel. The script
must be accessible through HTTP. You can verify the script accessibility using any web
browser. The script file is located in the "C:\Program Files (x86)\Devart\ODBC\Oracle\http
\tunnel.php" folder. The web server must support PHP 5 or later.

To set up an HTTP tunnel, specify the connection parameters on the HTTP and HTTPS Options

tab under security Settings.

© 2024 Enter your company name



66

ODBC Driver for Oracle

Devart ODBC Driver for Oracle Configuration x
General Advanced Settings Security Settings  License About

SSL Options  55H Options  HTTP and HTTPS Options

Use HTTF or HTTPS

LUrl |htn:|s:ﬂhl:ust|’ﬁ:ulderfb.|nnel.php
lser Mame |HttpLIser |
Password | SEEREEES |

[ ] Trust Server Certificate

Proxy Options

Host Mame |

Port |EI |

User Mame | |

Password | |

Test Connection - Cancel

HTTP Tunneling Options

Option Description

Use Http | Enables HTTP tunneling.

Http Url | The URL of the PHP script for HTTP tunneling.

Http User |The username for the password-protected directory that contains the
Name HTTP tunneling script.

Http The password for the password-protected directory that contains the

Password  |HTTP tunneling script.

Http Trust ) . . .
s Specifies whether to verify the server certificate during an SSL
erver
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handshake. When True, the driver bypasses walking the certificate chain

Certificate ) ) ]
to verify the certificate. The default value is False.

Sample Connection String Using HTTP Tunneling

DRIVER=Devart ODBC Driver for
Oracle;Direct=True;Host=myHost;Service Name=myServiceName;User
ID=myUsername;Password=myPassword;Use Http=True;Url=https://host/
folder/tunnel.php;Http User Name=myHttpUsername;Http
Password=myHttpPassword

Connecting Through HTTP Tunnel and Proxy Server

The HTTP tunneling server may be not be directly accessible from the client machine. In this
case, you need to additionally provide connection information for the proxy server.

© 2024 Enter your company name



68

ODBC Driver for Oracle

Devart ODBC Driver for Cracle Configuration pod
General Advanced Settings Security Settings  License  About
55L Options  SSH Options  HTTP and HTTPS Options
Use HTTF or HTTPS
Lrl |htms:ffhcust|’folderfb_|nnel.php
ser Mame |HttpLIser |
Password | EEEEEEES |
[ Trust Server Certificate
Proxy Options
Host Name |1III.I:I.I:I.1
Port |3128 |
lser Mame |F'rl:lxyLlser |
Password |-uuuu |
Test Connection Cancel
Proxy Options
Option Description
Proxy Host Name The proxy hostname or IP address.
Proxy Port The proxy port.

Proxy User Name

Proxy Password

The proxy username.

The proxy password.

Sample Connection String Using HTTP Tunneling and Proxy Server

DRIVER=Devart ODBC Driver for

Oracle;Direct=True;Host=myHost;Service Name=myServiceName;User
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ID=myUsername;Password=myPassword;Use Http=True;Url=https://host/
folder/tunnel.php;Http User Name=myHttpUsername;Http
Password=myHttpPassword;Proxy Host Name=myProxyHost;Proxy
Port=myProxyPort;Proxy User Name=myProxyuUsername;Proxy
Password=myProxyPassword

Additional Information

There is one more way to tunnel network traffic. The Secure Shell forwarding, or SSH, can be
used for data forwarding. However, SSH is designed to encrypt traffic rather than traverse
firewalls. The Connecting via SSH document describes how to set up an SSH connection in
the ODBC Driver for Oracle.

Note that traffic tunneling or encryption increases the CPU and bandwidth usage. It is
recommended that you use direct connection whenever possible.
© 2015-2024
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3.6 Sandboxed Apps on macOS

Sandboxed Apps on macOS

Sandboxed applications don’t have permission to access IODBC Driver Manager on macOS.
This is caused by the System Integrity Protection (SIP) technology on macOS which protects
your files and folders from potentially malicious software by locking the application. When
accessing a data source from an application like Excel through the ODBC driver for Oracle,

you may get an error message saying that the driver is unable to create a file.

Note that all third-party applications distributed through the Mac App Store are sandboxed.

Disabling System Integration Protection (SIP) on macOS

To resolve the issue, you should turn off SIP on your computer:

1. Restart your computer in Recovery mode (hold down Command + R until you see the
Apple logo).

2. Select Utilities > Terminal.
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3. In the Terminal window, enter csrutil disable.

@ [ ] Terminal — -bash — 80x24

-bazh-3.2# csrutil disable

Successfully disabled System Integrity Protection. Please restart the machine fo
r the changes to take effect.

-bash-3.2# rehuntl

4. Restart your computer.

5. Enter csrutil status to check the status of SIP.

[ ] & r5) test — paserver — -bash — BOx24

tests—imac-2:~ test$ csrutil status
System Integrity Protection status: disabled.
tests-imac-2:~ test$ [J

Enable SIP after you finish working with an ODBC data source. To turn on SIP, enter csrutil

enable and restart your computer.

© 2015-2024
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Using with iODBC

Using the Driver with iODBC

Among known issues with iODBC driver manager is incorrect handling of the following ODBC
data types:

e SQL_WCHAR
e SQL_WVARCHAR
e SQL_WLONGVARCHAR

For this reason, we recommend using the following data types instead:
e SQL CHAR

e SQL_VARCHAR
e SQL_LONGVARCHAR
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If you have to work with the SQL_WCHAR, SQL_WVARCHAR, and SQL_WLONGVARCHAR
data types, we recommend that you use the unixODBC driver manager rather than iODBC.

© 2015-2024
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3.8 Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows

When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled
or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any
other user login than your own, select Machine-wide tracing for all user identities. For
example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps
below.

1. Type obBC Data Sources in the Windows 10 search box (in earlier versions of Windows,
open control Panel > Administrative Tools) and choose the application of the needed

bitness.

2. Select the Tracing tab.

w

. If necessary, change the default Log File Path. Make sure that the path is writable by the

application, then click app1y.
. Click start Tracing Now.
. Restart all application processes.
. Click Test cConnection in the DSN settings to make sure the driver is able to connect.
. Reproduce the issue.

. Click stop Tracing Now on the Tracing tab.

© 00 N O o b

. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS

To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.
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1. Open the ODBC Administrator.
2. Select the Tracing tab.
3. If necessary, change the default Log file path.

4. Select A1l the time in the when to trace option.

Creating an ODBC Trace Log on Linux

To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the
[obBC] section of the /etc/odbcinst.ini file, for example:
[ODBC]

Trace=Yes
TraceFile=/home/test/devart.log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.
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Supported Data Types

Data Type Mapping

The Devart ODBC Driver for Oracle supports all Oracle data types.

The following table describes how the Oracle data types are mapped to the ODBC data
types.

Oracle Data Types ODBC Data Types
CHAR SQL_CHAR
VARCHAR2 SQL_VARCHAR
NCHAR SQL_WCHAR
NVARCHAR2 SQL_WVARCHAR
NUMBER SQL_NUMERIC
BINARY_FLOAT SQL_FLOAT
BINARY_DOUBLE SQL_REAL
DOUBLE PRECISION SQL_DOUBLE
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DATE
TIMESTAMP

SQL_TYPE_TIMESTAMP
TIMESTAMP WITH TIME ZONE
TIMESTAMP WITH LOCAL TIME ZONE
BLOB SQL_LONGVARBINARY
CLOB SQL_LONGVARCHAR
NCLOB SQL_WLONGVARCHAR
BFILE SQL_LONGVARBINARY
LONG SQL_LONGVARCHAR
RAW SQL_VARBINARY
LONG RAW SQL_LONGVARBINARY
ROWID

SQL_VARCHAR
UROWID
INTERVAL YEAR TO MONTH SQL_INTERVAL_YEAR TO_MONTH
INTERVAL DAY TO SECOND SQL_INTERVAL_DAY_TO_SECOND
XML SQL_LONGVARCHAR
else SQL_UNKNOWN_TYPE
© 2015-2024
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3.10 Supported ODBC API Functions

Supported ODBC Functions

The SQLGetInfo function returns information about the driver and data source. To find out
whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for Oracle supports all deprecated functions for backward compatibility.

The following table lists the currently supported ODBC functions.
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Function Name Support Standard Purpose
Obtains an

environment,
SQLAllocHandle .\/ ISO 92 connection,
statement, or
descriptor handle.
Connects to a
specific driver by
SQLConnect v ISO 92 data source name,
user ID, and
password.
Connects to a
specific driver by
connection string or
SQLDriverConnect v ODBC requests that the
Driver Manager and
driver display
connection dialog
boxes for the user.
Obtains an
SQLAllocEnv v Deprecated environment handle

allocated from driver.

Obtains a
SQLAllocConnect v Deprecated
connection handle

ODBC API Calls for Obtaining Information about a Driver
and Data Source

Function Name Support Standard Purpose

SQLDataSources v ISO 92 Returns the list of
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available data
sources, handled by
the Driver Manager
Returns the list of
installed drivers and
SQLDrivers v, ODBC their attributes,
handles by Driver
Manager
Returns information
SQLGetInfo v, ISO 92 abouta specific
driver and data
source.
Returns the functions
SQLGetFunctions v, ISO 92 supported by the
driver.
Returns information
SQLGetTypelnfo v ISO 92 about supported

data types.

ODBC API Calls for Setting and Retrieving Driver

Attributes
Function Name Support Standard Purpose
Sets a connection
SQLSetConnectAttr v ISO 92
attribute.
Returns the value of
SQLGetConnectAttr v ISO 92 a connection
attribute.
SQLSetConnectOpti Sets a connection
v, Deprecated
on option
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SQLGetConnectOpti b ed Returns the value of
eprecate

on v a connection option

Sets an environment
SQLSetEnvAttr v ISO 92 ribut

attribute.

Returns the value of
SQLGetEnvAttr v ISO 92 an environment

attribute.

Sets a statement
SQLSetStmtAttr v ISO 92 ribut

attribute.

Returns the value of
SQLGetStmtAttr v, ISO 92

a statement attribute.

. Sets a statement

SQLSetStmtOption v Deprecated

option

. Returns the value of

SQLGetStmtOption v, Deprecated

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name Support Standard Purpose
Allocates a
SQLAllocStmt ' Deprecated
statement handle
Prepares an SQL
SQLPrepare ' ISO 92 statement for later
execution.

Assigns storage for

SQLBindParameter v ODBC a parameterinan
SQL statement.
Returns the cursor
SQLGetCursorNam
' ISO 92 name associated
e

with a statement
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handle.
SQLSetCursorNam Specifies a cursor
v, ISO 92
e name.
. Sets options that
SQLSetScrollOption
v, ODBC control cursor
s
behavior.

ODBC API Calls for Submitting Requests

Function Name Support Standard Purpose

Executes a prepared
SQLExecute v ISO 92
statement.

) Executes a
SQLExecDirect v ISO 92
statement
Returns the text of an
) SQL statement as
SQLNativeSq| v ODBC
translated by the
driver.
Returns the
] description for a
SQLDescribeParam v ODBC
specific parameter
in a statement.
Returns the number
SQLNumParams v ISO 92 of parameters ina

statement.

Used in conjunction

with SQLPutData to
SQLParamData v, ISO 92 supply parameter

data at execution

time. (Useful for long
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SQLPutData

ISO 92

data values.)

Sends partor all of a
data value for a
parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information

about Results

Function Name

SQLRowCount

SQLNumResultCols

SQLDescribeCol

SQLColAttribute

SQLColAttributes

SQLFetch

SQLFetchScroll

SQLExtendedFetch

Standard

ISO 92

ISO 92

ISO 92

ISO 92

Deprecated

ISO 92

ISO 92

Deprecated

Purpose
Returns the number

of rows affected by
aninsert, update, or
delete request.
Returns the number
of columns in the
result set.
Describes a column
in the result set.
Describes attributes
of a column in the
result set.
Describes attributes
of a columnin the
result set.

Returns multiple
result rows.

Returns scrollable

result rows.

Returns scrollable
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SQLSetPos

SQLBulkOperations

ODBC

ODBC

result rows.
Positions a cursor
within a fetched
block of data and
enables an
application to refresh
data in the rowset or
to update or delete
data in the result set.
Performs bulk
insertions and bulk
bookmark
operations, including
update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic

Information

Function Name

SQLError

SQLGetDiagField

SQLGetDiagRec

Support

Standard

Deprecated

ISO 92

ISO 92

Purpose
Returns additional

error or status
information

Returns additional
diagnostic
information (a single
field of the
diagnostic data

structure).

Returns additional
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diagnostic
information (multiple
fields of the
diagnostic data

structure).

ODBC API Calls for Obtaining Information About

Database Objects (Catalog Functions)

Function Name

SQLColumnPrivileg

es

SQLColumns

SQLForeignKeys

SQLPrimaryKeys

SQLProcedureColu

mns

Standard

ODBC

X/Open

ODBC

ODBC

ODBC

Purpose
Returns a list of

columns and
associated
privileges for one or
more tables.
Returns the list of
column names in
specified tables.
Returns a list of
column names that
make up foreign
keys, if they exist for
a specified table.
Returns the list of
column names that
make up the primary

key for a table.

Returns the list of
input and output

parameters, as well
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as the columns that
constitute the result
set for the specified
procedures.
Returns the list of
SQLProcedures v ODBC procedure names
stored in a specific
data source.
Returns information
about the optimal set
of columns that
uniquely identifies a
row in a specified
SQLSpecialColumn table, or the columns
v, X/Open
S that are
automatically
updated when any
value in the row is
updated by a
transaction.
Returns statistics
about a single table
SQLStatistics v, ISO 92 and the list of
indexes associated

with the table.

Returns a list of

tables and the
SQLTablePrivileges v, ODBC o

privileges

associated with
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each table.

Returns the list of

table names stored
SQLTables v X/Open

in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name Support Standard Purpose

Commits or rolls
SQLTransact ' Deprecated _
back a transaction

Commits or rolls
SQLEndTran v ISO 92
back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard Purpose
Ends statement

processing, discards
pending results, and,
SQLFreeStmt v ISO 92 optionally, frees alll
resources
associated with the

statement handle.

Closes a cursor that

SQLCloseCursor v ISO 92 has been opened on
a statement handle.
Cancels an SQL
SQLCancel v ISO 92
statement.

ODBC API Calls for Terminating a Connection
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Function Name Support

Standard
ISO 92

ISO 92

Deprecated

Deprecated

ODBC Forum

Purpose
Closes the

connection.
Releases an
environment,
connection,
statement, or
descriptor handle.
Releases connection
handle.

Releases an

environment handle.

Provide Feedback

SQLDisconnect '
SQLFreeHandle v
SQLFreeConnect \/
SQLFreeEnv v,

© 2015-2024
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4 Using in Third-Party Tools

This section discusses how to use ODBC Driver for Oracle with ODBC-compliant tools.

e DBeaver
e Denodo

¢ Oracle Database Link

e Microsoft Access

¢ Microsoft Excel

¢ OpenOffice and LibreOffice

* PHP
e Power Bl
* Python

e QlikView
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e SQL Server Management Studio

e SSIS

e Tableau
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Using in Microsoft Access

Connecting Microsoft Access to Oracle Using an ODBC
Driver

This article explains how to connect Microsoft Access to Oracle through the standard ODBC
interface. Microsoft Access is a dababase management system that combines the relational
database engine with a graphical user interface. Access can be used as a substitution for
spreadsheet applications like Excel to organize, store, and retrieve large amounts of related
data that can be difficult to manage in spreadsheets.

In Microsoft Access, you can connect to your Oracle data either by importing it or creating a
table that links to the data. Devart ODBC drivers support all modern versions of Access. ltis
assumed that you have already installed and configured a DSN for ODBC driver for Oracle.
For the purpose of this article, we tested an ODBC connection to Oracle through our ODBC

drivers in Microsoft Access 2003, Microsoft Access 2007, Microsoft Access 2010, Microsoft
Access 2013, Microsoft Access 2016, Microsoft Access 2019. The following steps describe
how to use Microsoft Access 2019 to import or link to your data in Oracle.

Importing Oracle Data Into Microsoft Access Through an ODBC

Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.

5. In the Select Data Source dialog box, select the Machine Data Source tab.
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6. Select the DSN that you have configured for Oracle and click OK.

7. In the Import Objects dialog box, select the tables that you want to import, and click OK.

8. If the database objects have been successfully imported, you should the see the
corresponding message in the dialog box. If you want to save the import steps to quickly
repeat the process without using the wizard at a later time, select the Save import steps
checkbox. Click Close.

9. The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to Oracle Data in Microsoft Access Through an ODBC

Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Link to the data source
by creating a linked table.

5. In the Select Data Source dialog box, select the Machine Data Source tab.

6. Select the DSN that you have configured for Oracle and click OK.

7. In the Link Tables dialog box, select the table or tables that you want to link to, and click
OK.

8. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields
that uniquely identify each record in the table. To avoid inconsistencies, it is recommended
to select the primary key in the Oracle table as the unique record identifier. You are linking
multiple tables, you will be prompted to select unique record identifiers for each of the
selected tables.

9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.
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Using in DBeaver

DBeaver Overview

DBeaver is a free, open source multiplatform database management tool and SQL client for
developers and database administrators. DBeaver can be used to access any database or
cloud application that has an ODBC or JDBC driver, such as Oracle, SQL Server, MySQl,
Salesforce, or Mailchimp. Devart DBeaver provides you with the most important features
you'd need when working with a database in a GUI tool, such as:

e SQL queries execution

¢ Metadata browsing and editing
e SQL scripts management

e Data export/import

e Data backup

e DDL generation

e ER diagrams rendering

¢ Test data generation

e BLOB/CLOB support

e Database objects browsing

e Scrollable resultsets

The tool comes in two editions — Community and Enterprise. Enterprise Edition supports
NoSQL databases, such as MongoDB or Cassandra, persistent query manager database,
SSH tunneling, vector graphics (SVG) and a few other enterprise-level features. Note though
that you can access a MongoDB database from DBeaver Community Edition using the
respective Devart ODBC driver. For the purposes of this guide, we'll use the Community
Edition of DBeaver to retrieve data from Oracle via the Open Database Connectivity driver.

Creating an ODBC Data Source to Use Oracle Data in
DBeaver

1. Click the Start menu and select Control Panel.
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2. Select Administrative Tools, then click ODBC Data Sources.

3. Click on the System DSN tab if you want to set up a DSN name for all users of the system

or select User DSN to configure DSN only for your account.
4. Click the Add button and double-click Devart ODBC Driver for Oracle in the list.
5. Give a name to your data source and set up the connection parameters.

6. Click the Test Connection button to verify that you have properly configured the DSN.

When using ODBC driver for Oracle with DBeaver, SQL_WVARCHAR data types may be
displayed incorrectly in DBeaver. To prevent this, you need to set the string data types to Ansi
either in the Advanced Settings tab of the driver configuration dialog or directly in the
connection string (String Types=Ansi) — all string types will be returned as SQL_CHAR,
SQL_VARCHAR and SQL_LONGVARCHAR. Below you will see guidelines on how to
connect Oracle database in DBeaver.

Devart ODBC Driver Configuration et

General Advanced settngs  |jcense  About

Meta Data
- —— . p—_—. e -
Connection
-
L
Compatibility
ODBC Behavwior Default b
String Types Ansi (SQL_CHAR, SQL_VARCHAR, SQL_LONC

Use Local Regional Settings when converting to string

] Mumbers []Dates and times

Test Connection vor Cancel
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Connecting to Oracle Data from DBeaver via ODBC
Driver for Oracle

Follow the steps below to establish a connection to Oracle in DBeaver.

1. In the Database menu, select New Database Connection.

Yy DBeaver 6.1.5

Eile Edit Mavigate Search SOL Editor | Database Window Help

¢ | 9 | 7 I3 i 4 + % NewDatabase Connection
L]

_ ) =% Driver Manager
f® Database Mavigator i3 | [F Projects

¥ Connect

Invalidate/Reconnect
Enter a part of table name here

QODEC - xBase_xbd
ODBC - ZohoCRM_x64

Change Connection(s) Driver

&, ODBC - MailChimp_x64 Pisconned

= ODBC - MongoDB_x64 Disconnect All

= ODBC - Oracle x64 20 compare/Migrate >
= ODBC - salesforceMC_x64 3 Tools ,
= ODEC - SugarCRM_x64 Context tools Al

2. In the Connect to database wizard, select ODBC and click Next.

fw Connect to database O >

(1

Select your database
ODBC bridge driver

Type part of database/driver name to filter & Gallery

Mame # ~
= ODBC 7
& Apache Ignite
5 AwWS
A Azure

3. Enter the previously configured DSN in the Database/Schema field.
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Generic JDBC Connection Settings

, _ = O0DBC
ODBC connection settings

General Driver properties 55H Proxy

JDBC URL: ‘ jdbciodboDBEAVER_DATASOURCE

Database/Schema: | DBEAVER_DATASOURCE |

User name: ‘ |

Passward: ‘ | Save password locally

4. Click Test Connection. If everything goes well, you'll see the Success message.

Viewing Oracle Database Objects and Querying Data

You can expand out the database structure in DBeaver's Database Navigator to visualize all
the tables in Oracle database. To view and edit the data in a table, you need to right-click on
the target table name and select View data.The content of the table will be displayed in the
main workspace.

'y DBeaver 6.1.5 - EMPLOYEES
File Edit MNavigate Search 30l Editor Database Window Help

¢ - e w0 _['_',_ T+  Auto @' -
= Databa... 3 Projects = B | BB EMPLOYEES 3 AUTOTEST
¢ - | = £ properties | [ Data | 5o ER Diagram = ODBC - Oracle_x64
Enter a part of table name here
P DETAIL ~ | |BempLovees |23
B DML_ARRAY =z ABE LAST_NRﬂ REC EMAIL T1| mec JOB_TITLE
g Eﬁ;‘ARRAY‘TIMESTN % 1 | Ardern jardern0@va.gov Electrical Engineer
v 2 | Krystek ikrystek1@mayoclinic.com Chemical Engineer
BB Columns § 3| Mullinder amullinder2@fotki.com Graphic Designer
BE Unique Keys B 4 | Deshorts edeshorts3@cdbaby.com Software Consultant
M Foreign Keys 5 | Strass mstrass4é@photobucket.com Compensation Analyst
B indexes & | Huard shuard>@apache.org Geologist Il
B References 7 | Lennard dlennardé@webs.com Clinical Specialist
EE ENCRYPT TYPES Z McPheat Imecpheat7@jigsy.com Registered Murse

© 2024 Enter your company name



90

ODBC Driver for Oracle

4.3

If you want to write a custom SQL query that will include only the necessary columns from the
table, you can select New SQL Editor in the SQL Editor main menu. Create your query and

run it by clicking Execute SQL Statement to view the results in the same window.

= Databa.. 2 Projects = B [T *<ODBC - Oracle_x64> Script-5 52
¢~ | - > SELECT FIRST NAME, LAST NAME FROM EMPLOYEES;
Enter a part of table name here b
B DETAIL ] o
FB DML_ARRAY P
BB DML_ARRAY TIMESTAP b EMPLOVEES &3
B EMP T SELECT FIRST_NAME, LAST |23
v z ABE FIRST_ NAME 3| A5C L AST NAME T3
A Columns =
123 |D {(NUMBER{15,: H 1 | Ardern
AEC FIRST_NAME (VA 2 |lsis Krystek
ABC LAST MNAME (VAF 5 3_ Addy Mullinder
REC EMAIL (VARCHAF B 4 Eleen Deshorts
ABEC JOB_TITLE (VARC - 5_ Missy Strass
AEC CITY (VARCHARZ2 6| Sigvard Huard
REC UMIVERSITY (WAF 7 Dahlia Lennard
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Using in Denodo

Troubleshooting ODBC Connection in Denodo

When you attempt to access Oracle from Denodo with default settings, you may get an
'‘Unexpected error creating a connection: Unable to validate object Received exception with
message 'Unable to validate object". To resolve the error:

1. Select File > New > Data Source > ODBC in Virtual DataPort Administration Tool.
2. Click Connection Pool configuration.

3. In Ping query, change select 1 t0oSelect 1 From DUAL, then click Ok.
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g *new_datasource

Connection Pool Configuration

Initial size: 4
Maximum number of active connections: 20

Test connections
Select 1 From DUAL

Ping query:

“ Cancel
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4.4 Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC

This article explains how to configure Oracle Database Gateway for ODBC. If your data is
stored in a non-Oracle database system or cloud application, and you need to access it from
an Oracle Database server, you can create a database link to an Oracle Database Gateway
for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,
remote Oracle servers. Any ODBC-compatible data source can be accessed using the
gateway and the appropriate ODBC driver. The driver must be installed on the same machine
as the gateway. The non-Oracle system can run on the same machine as the Oracle server
or on a different machine. The gateway can be installed on the machine running the non-
Oracle system, the machine running the Oracle database or on a third machine as a
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standalone.

Configure the Initialization File

After installing the gateway and the ODBC driver for Oracle, create an initialization file for your

Oracle Database Gateway for ODBC. The sample file initdg4odbc.ora is stored in the
ORACLE_HOME\hs\admin directory. To create an initialization file for the gateway, copy the
sample initialization file and rename it. The name must be prefixed with init — for example,
initoracle.ora. YOu need a separate initialization file for each ODBC data source. After
creating the file, set the Hs_Fps_conNeEcT_INFO parameter to the system DSN that you created
earlier, for example:

HS_FDS_CONNECT_INFO=Oracle

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with
the Oracle database. Information about the gateway must be added to the 1istener.ora
configuration file which is located in the orRACLE_HOME\NETWORK\ADMIN\ directory. The following
example is the address on which the Oracle Net Listener listens (HosT is the address of the
machine on which the gateway is installed):
LISTENER =

(DESCRIPTION_LIST =

(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP) (HOST = localhost) (PORT = 1521))

)

Add an entry to the 1istener.ora file to start the gateway in response to connection requests.
The SID of the gateway (s1p_NamMe) must be the same in 1istener.ora and tnsnames.ora.
ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new
settings, stop and restart the Oracle Net Listener service.
SID_LIST_LISTENER=
(SID_LIST=
(SID_DESC=
(SID_NAME=0Oracle)

(ORACLE_HOME=D: \ORACLE_HOME)
(PROGRAM=dg4odbc)

)

Configure Oracle for Gateway Access
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Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in
ORACLE_HOME \NETWORK\ADMIN directory. The s1p must match the value specified in the

listener.ora file.

Ooracle =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = tcp) (HOST = 1oca1host) (PORT = 1521))
(CONNECT_DATA =
(SID = oOracle)

)
(HS = OK)

Create Database Links

To access an ODBC data source, you must create a database link using a database tool like

SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the

CREATE DATABASE LINK statement, as follows:

CREATE DATABASE LINK dblink CONNECT TO "username" IDENTIFIED BY "password"

dblink is the complete database link name. tns_name_entry is the Oracle Net connect
descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a
query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"dblink_name"

See also

Configuring Oracle Database Gateway for ODBC
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4.5 Using in Microsoft Excel

Connecting to Oracle from Microsoft Excel using ODBC
Driver for Oracle

You can use Microsoft Excel to access data from a Oracle database using ODBC connector.
With ODBC Driver, you can import the data directly into an Excel Spreadsheet and present it
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as a table. Make sure that you use matching Excel and ODBC Driver, e.g. if you have
installed a 64-bit ODBC Driver, you will need to use the 64-bit version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various
data sources using our ODBC drivers. Please see the list of sections that will help you to
connect Excel to Oracle database:

e Connecting Excel to Oracle with Get & Transform (Power Query)

e Connecting Excel to Oracle with Data Connection Wizard (Legacy Wizard)

e Connecting Excel to Oracle with the Query Wizard

e Connecting Excel to Oracle with Microsoft Query

e Connecting Excel to Oracle with PowerPivot

Connecting Excel to Oracle with Get & Transform
(Power Query)

You can use Get & Transform (Power Query) to connect to Oracle from Excel with ODBC.
This method assumes that you've installed an ODBC driver for Oracle.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other

Sources > From ODBC.
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Bookl - Excel Evgeniy Lemeshov [ O
Insert Page Layout Formulas Review View Help & Tellme X Share
& (o |_ B  a [TA N E Be B 5
]
B, g2 o Y:&. " B B =
B i - .
Get Refresh z| Sort Filter Text to G What-If Forecast Outline
Data ~ D All = Y cColumns =8 7 Ex Analysis =~  Sheet M
G Sort & Filter Data Tools Forecast ~
j From File L
C w
[y
From Database L - - - - " ' ' =
— 4 »
Ry 0 - ] + 100%
= am From Azure » From Table/Range

From Online Services * _@ From Web

LS
:.‘2. From Other Sources * From Microsoft Query

N
Combine Queries 4 _.¢. From QDBEC

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured
your ODBC driver yet, you can expand the Advanced Options dialog box and enter the
connection string for your data source (without credentials, which are defined in the
credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.
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4
From ODBC
Data source name (DSN)
Devart ODBC Driver -
4 Advanced options
Connection string (non-credential properties) (optional) &
501 statement [optional)
SELECT * FROM MyDatabase.MyTable;
Supported row reduction clauses (opticnal)
(Mone) = Detect
3. If you're using a database username or password, select Database and enter your
credentials in the dialox bog, then click Connect.
ODEC driver =
Default or Custom < dsn=Devart ODBC Driver
. Use a username and password to access a data source with an QDBC driver,
Windows
User name
Database Myusemname
Password
FERRRERREEE

Credential connection string properties (optional) (O

Back Cancel
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If your database is not password-protected or you've already specified your credentials in the
ODBC data source settings, select Default or Custom and press Connect

Default or Custom '¢'d§”:DE'{S'__ ODBC Driver

Wind Don't specify any credentials or only connection string properties.
indows

Credential connection string properties (optional) (D)

Database

Back Cancel

4. In the window that appears, select the table you want to retrieve data from, and click Load.

O X
Navigator
P EMPLOYEES B
Select multiple items ID FIRST_MAME  LAST_NAME EMAIL JOB_TI
Display Options ~ [% 1|lanek Ardern jardernl@va.gov Elec
EA DEPT 2|lsis Krystek ikrystek 1@ mayoclinic.com Che
~ 3 Addy Mullinder amullinder2@fotki.com Gra
EH DETAILL
4|Eleen Deshorts edeshorts3@cdbaby.com Soft
= DML_ARRAY 5| Missy Strass mstrassd@photobucket.com Con
El DML_ARRAY TIM... & Sigvard Huard shuard>@apache.org Gec
E EMP 7| Dahlia Lennard dlennardé@webs.com Clin
I EMPLOYEES &8 Liane McPheat Imcpheat? @jigsy.com Regv
_ LW 9| Zallie Verity wverityB @thetimes.co.uk We
EH ENCRYPT TYPES < >
Select Related Tables load |~ Transform Data Cancel

The data from the table will be a displayed in an Excel spreadsheet where you can further
work with it.
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H Book2 - Excel Evgeniy Lemeshov

File Hom | Inser | Page | Form | Data | Revie | View | Help | Table Design | Query O‘ Tell me ,f:i Share

2 | 1 Janek Ardern jardern0@va.gov Electrical Engineer Bu:

3 | 2 Isis Krystek ikrystekl@mayoclinic.com  Chemical Engineer Wic

4 3 Addy Mullinder amullinder2@fotki.com Graphic Designer Taj

5 | 4 Eleen Deshorts edeshorts3@cdbaby.com Software Consultant Pe

6 | 5 Missy Strass mstrassd@photobucket.com Compensation Analyst Me
7| 6 Sigvard Huard shuards@apache.org Geologist Il Cha

8 | 7 Dahlia Lennard dlennards@webs.com Clinical Specialist Ci

9 | 8 Liane McPheat Imcpheat7@]igsy.com Registered Nurse Bo
10 | 9 Zollie Verity zverityB@thetimes.co.uk Web Designer Il Lin -

Sheet1l | Sheetl | ® 1 3

Connecting Excel to Oracle with Data Connection
Wizard (Legacy Wizard)

You can use this option to connect to OLE DB or ODBC external data source that has
already been defined.

1. In Excel, go to the Data tab. Click From Other Sources, and then click From Data
Connection Wizard.

2. In the opened dialog, select ODBC DSN and click Next to continue.

3. Now select a data source you want to connect to, and click Next.

4. To connect to the table containing the required data, select its name and click Next to enter
and save information about your new file or click Finish.

5. In the Import data dialog, you can select the way your data will be viewed in Excel and the
place where to put it in the worksheet, and click OK.

6. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to Oracle with the Query Wizard

You can use this option to create a simple query for retrieving data from Oracle to Excel via
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ODBC driver.

1.
2.
3.

0 N O O

Open Excel, in the main menu, click the Data tab.
Click the From Other Sources dropdown menu, and then click From Microsoft Query.

In the appeared dialog, you can choose the data source you want to connect to.

. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.

. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.
. If you plan to further use the query, you can save it by clicking the Save button on the right.
. Select Return Data To Microsoft Excel and click Finish.

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

. The required data is successfully imported to Excel.

Connecting Excel to Oracle with Microsoft Query

You can use this option to create a more complex query for retrieving Oracle data to Excel via
ODBC driver.

1.
2.
3.

Start Excel, click the Data tab.
In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

In the next dialog, choose the data source you want to connect to (e.g., using data source
name - Devart ODBC Oracle). Uncheck Use the Query Wizard to Create/Edit Queries
and click OK.

. Now you can select the tables you want to add to your query. When you finish, just click

the Add button.

. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to Oracle with PowerPivot

You can use PowerPivot - an Excel add-in to perform data analysis and create complex data

models. To load the required data, do the following:

1.

In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.
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4.6

46.1

. In the opened window, click From Other Sources.
. When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

. In the Specify a Connection String window, click the Build button.

a A W N

. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,
using data source name - Devart ODBC Oracle), and then click Next.
6. Now you should choose how to import the data (either select a table from the list or write a
query to specify the data to be imported).
7. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.
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Using in SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to Oracle from SQL
Server Management Studio using ODBC Driver for Oracle.

¢ Creating a Linked Server

e Troubleshooting in SSMS

© 2015-2024
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Creating a Linked Server

Requirements

In order to avoid incorrect integration with MS SSMS, the working environment must meet the
following conditions:

¢ The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN
¢ The driver, studio, and SQL Server must be of the same bitness. For example, if you are
using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure

the 64-bit version of the driver using ODBC Administrator launched from %windir%
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\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC
Administrator - launch it from %windir%\SysWOW64\odbcad32.exe.

e ODBC Diriver for Oracle and SQL Server must be installed on the same computer.

e NET Framework 4.5 must be installed on the computer.

Connecting to Oracle from SQL Server Management
Studio using ODBC Diriver for Oracle

You can use the Microsoft SQL Server Management Studio to connect your Oracle data to an
SQL Server instance. Linked Server is a tool of MS SQL Server that allows to execute
distributed queries to refer tables stored on non-SQL Server datbase in a single query. With
linked servers, you can execute commands against different data sources such as Oracle
and merge them with your SQL Server database. You can create a linked server with one of
these methods: by using the options in the Object Explorer or by executing stored
procedures.

Below are major advantages of using SQL Server Linked Servers to connect to Oracle:

1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the

organization.

3. The ability to work with diverse data sources in the same way.

How to configure a SQL Server Linked Server to connect
to Oracle

You can follow the steps to create a linked server for Oracle in SQL Server Management
Studio by using Object Explorer:

1. Start your Management Studio and choose your SQL Server instance.
2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers

and then click on New Linked Server.
3. Configure your linked server in the dialog box:
¢ Give a name for your server in the Linked server field.

e Under Server type, select Other data source .
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e Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down

list.

¢ |n the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for

Oracle . Alternatively, you can input the ODBC Driver connection string in the Provider

field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can

now issue distributed queries and access Oracle databases through SQL Server.

Retrieving Data From Oracle

Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is
enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on

it

Object Explorer = 0 x

Connect~ ¥ *¥ (VI

Databases
Security
= Server Objects
Backup Devices
= Linked Servers
=] Providers
@8 ADsDSOObject
@8 MSDAOSP
w8 MSDASQOL
wE MSOLAP
wh MSOLEDBSQL
@b Search.CollatorDsSO

= @ EVGENIYL\SQLEXPRESS (SQL Server 14.0.1000 -

In the appeared Provider Options window, enable the Allow inprocess checkbox:
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@E Provider Options - Microsoft OLE DB Provider for ODBC Drivers - O x
Selecta page IT Script ~ &) Help
& General

Provider options:

Enable Name -
Dynamic parameter
MNested queries
Level zero only
Allow inprocess
Maon transacted updates
Index as access path

Disallow adhoc access

Supports Like' operator W

Limlemd mmmamen samimn thin meossid e

Create a new Linked Server

Object Explorer * I x
Connect~ ¥ ¥ ¢ o+
= @ EVGENIYL\SQLEXPRESS (SQL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
:
Providers |_ Mew Linked Server...
Triggers

Start Powershell

Replication
PolyBase Reports '
Management Refresh

HEvent Profiler

3]

Make sure to select Microsoft OLE DB Provider for ODBC Drivers:
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H New Linked Server = O *
# General
& Security
& Server Options b
Server type:
() 5QL Server
(®) Other data source
Pravider: Microsaft OLE DB Provider far ODBC Drivers w
Product name: | |
Data source: | |
Provider string: | |
Location | |
Catalog | |

Connechon

Now you need to input the Linked Server name, e.g. ORACLE. In the Product Name and Data

Source fields you need to indicate the System DSN that you've previously created - more info

on System DSN setup can be found here.

A New Linked Server = O *
Select a page HScriptveHelp
# General
& Securty
& Server Options Shtles=— ORACLE
Server type:
() 50L Server
(®) Other data source
Provider: Microsoft OLE DB Provider for ODBC Drivers ~
Product name: |Deuart ODBC Driver for Oracle |
Data source: |Orac|e |
Provider string: | |
Location | |
Catalog | |

Connection

The Oracle tables are already available to be fetched. To query the linked server, click New

Query in the toolbar:
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File Edit View Project SQOL Complete Tools  Windoy
i0-0|8®-1-2 | B New Query B 5 &
: | | P Execute

———————————————————————————
Object Explorer = 0 x

Connect~ ¥ *¥ (VIS

=] E EVGEMIYLASQOLEXPRESS (5QL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
.
Providers
H ORACLE
B POSTGRESGL
B sauTe

B EHEBH

Enter your SQL query in the editor window and click Execute to run the query:

L:}; SQLQuery1.5ql - EVGENIYL\SQLEXPRESS.master (sa (54))* - Microsoft SQL Server Management 5t...  Quick Launch (Cirl+Q) Pl = 0O x
File Edit View Query Project SOL Complete Tools Window Help

(@08 -t Rl By BRAKD| XTH[D-0 B e

\r| master - | P Execute Vv io | 2 is i—“||m';5|mr_‘|| E '°—§|:E §=|'@:
Object Explorer SQLQuery1.sql - E.S.master (sa (34))* = -
s .* x,* 0 * -]SELECT * FROM OPEMQUERY ( ORACLE ,'SELECT * FROM AUTOTEST.EMPLOYEES'); %
Y
5 FRESHBOOKS A b1
B INTERBASE
B MaGeENTO >
H MaILCHIMP w00% -I§ D
5§ monNGoDs B Resuts [ Messages
B ms saL SERVER ID FIRST_NAME LAST_MNAME EMAIL JOB_TITLE CIT A
5 MYSQL 1 Janek Ardem jardem0@va.gov Electrical Engineer Buz
B MNETSUITE 2 2 lsis Krystek ikrystek 1@mayoclinic.com Chemical Engineer Vict
= B oRaCLE 3 3 Addy Mullinder amullinder2@fotki.com Graphic Designer Taiji
=] Catalogs 4 4 Eleen Deshorts edeshorts 3@cdbaby .com Software Consultant Peti
System Catalogs 5 5 Missy Strass metrassd@photobucket. com  Compensation Analyst Mei
= @ default [ 6 Sigvard Huard shuard 5@apache.org Geologist || Chz
Tables 7 7 Diahlia Lennard dlennard6@webs.com Clinical Specialist Cim
Views a8 a Liane McPheat Imcpheat 7&@jigsy.com Registered Nurse Bok
B POSTGRESQL 9 5  Zolie Verity zverityB@thetimes.co.uk Web Designer |1l Linc
B QUICKBOOKS 10 10 Tonia Mathey tmathey9@amazon.de Senior Financial Analyst Ma:
11 11 Anni Burch aburcha@nbecnews.com Computer Systems Analyst IV Kine
8 saL azure :
12 12 Malory Youthed myouthedb@stanford edu Software Test Engineer || Ben
= B saLTE T o . - - : ——Kd
B SUGARCRM v it >

As a result, you can see the contents of the selected table retrieved directly from the Oracle
account you are connected to.
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4.6.2

See also

¢ Troubleshooting SSMS
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Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with
DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security
settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its

properties:
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-
. Compenent Services

Console Root
a 0 Component Services
4[] Computers
a & My Computer
» [o] COM+ Applicatio
[ -] DCOM Config
& [2] Running Processe
[ fj] Distributed Trans:
[ E Event Viewer (Local)
3 Q.,, Services (Local)

Windo.., Windows... Windows R.. Windows R...
Microsoft Microsoft Microsoft Microsoft
Windo.,..  Windows.. WMIPro.. WMIProvi.

s & & &

Micresoft.... Microsoft.L... MicrosoftV... Microsoft....

ApplD
MMC (ALY MSMDPP - MsRdpSess...
Applicati.. LIZE

¥ & & &

MSTTS MahimicSe... MAP Agent Map Elevated
DecObj Cla.. Service COM class
NCLUA NDFAPI netman netprofm

¥ & & @&

NetProjW  Metwork and  Offline Files  OpenSearch
Sharing Ce... Service Description...

More Actions »

4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:
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-

MSDAINITIALIZE Properties

| General | Location | Securty | Endpoirts | Idertity |

(71 Use Default

i@ Customize

Access Permissions

(71 Use Default

i@ Customize

(71 Use Default

i@ Customize

Launch and Activation Permissions

Corfiguration Pemissions

Leam more about setting these properties.

[ OK ][ Cancel ] Apply

5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions

available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are

connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-
11D1-89E0-00C04FD7A829}

© 2024 Enter your company name



Using in Third-Party Tools| 109

3. Right Click>Permissions>Advanced>Owner Tab:

-

. _ N
. Advanced Security Settings for {2206CDB0-19C1-11D1-89E0-00C04FD7AB29} S

sgiii

Pemissions I Auditing | Owiner | Effective Permissions

You can take or assign ownership of this object f you have the required permigsions or privileges.

Current owner:

< - s i = iy et o -

Change ownerta:

Name

Cither users or groups...

[7] Beplace owner on subcontainers and objects

e e e o P A At
SRRRRRRRATY

Leam about ohject ownership

. R e e r oy T R R PP 0.

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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4.7

-

-
. Permissicns for {2206CDE0-19C1-1101-89E0-00C04F... M

Securty

Group or user Names:
QJ__NETWDHK SERVICE £

E4d Administrators {0 0
52, Users | “Users)

82 Trustedinstaller s
1| 1] bareals

Pemissions for Administrators Allow Dery

Full Cortrol O
Read 0

Special permissions

For special pemissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

ok ] [Cance 7] [ oy

After this you should be able to edit MSDAINITIALIZE security settings .

See also
e Error message when you try to create an instance of an OLE DB provider in SQL Server:
"Cannot create an instance of OLE DB provider"

© 2015-2024

Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

Using in OpenOffice and LibreOffice

Connecting to Oracle from OpenOffice and LibreOffice
using ODBC Driver for Oracle
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The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data
sources using the respective driver. You can access Oracle data from Open Office Base or
LibreOffice Base — desktop database management systems. Note that the Windows version
of OpenOffice is 32-bit, and you may get the error “The specified DSN contains an
architecture mismatch between the Driver and Application” when trying to access a data
source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-bit
version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for
Oracle, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.

Apache i ™
€5 OpenOffice™ 4

‘E Text Document; Drawing
Spreadsheet EE] Database
Presentation E Formula

@ Open... = |_r/_| Templates..

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.
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iZ| Untitled 1 - O penOffice Writer

File Edit

] New
2 open..

Recent Documents

View [nsert

Ctri+ 0

@

Wizards

Close
Ctrl+5
Ctrl+5hift+5

Save

o O &

Save As..
Save All

Reload
Versions...
Export..

Export as PDF...
Send

]

"

2. In the Database Wizard dialog box, click Connect to an existing database, select

Farmat

M FWE B E W

T

Table

Tools
Text Document Ctri+M
Spreadsheet

Presentation

Drawing

Database

HTML Document
XML Form Document

Master Document

Formula
Labels

Business Cards

Templates and Documents

Window Help

ODBC from the drop-down list, and click Next.
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Database Wizard

Steps Welcome to the OpenOffice Database Wizard
1.5elect database Use the Database Wizard to create a new database, open an existing database file,
2.Set up ODBC connection or connect to a database stored on a server.

3.5et up user authentication

4.5ave and proceed

What do you want to do?
(0 Create a new database

O Open an existing database file

Recently used

|Ne-.'—.- Database2

=5 Open...

(® Connect to an existing database

QODBC s
Help << Back | Mext == | Finish Cancel

3. Specify the name of the data source you want to connect to. You can either type the name
of your data source into the field, e.g. ODBC Driver for Oracle, or you can click Browse,

double-click the data source you need, and then click Next.

Database Wizard

Steps Set up a connection to an ODBC database

1. 5elect database Enter the name of the ODBC database you want to connect to,

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

Please contact your system administrator if you are unsure about the following
settings.

Set up ODBC connection
3.5et up user authentication

4, Save and proceed

Mame of the ODBC data source on your system

Browse
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Data Source *
Choose a data source: oK
Devart ODBC Driver
Devart ODEBC Driver for SQLite_32 Cancel
Devart ODBC Driver_32bit
QDBC Driver for MySQL_32bit Help
QOrganize...
Database Wizard e
Steps Set up a connection to an ODBC database
1.Select database Enter the name of the ODBC database you want to connect ta.

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

2.5et up ODBC connection

4.Save and proceed

MName of the ODBC data source on your system

Devart ODBC Driver_32bit

Help << Back Mext == Einish Cancel

4. If your database requires a user name, type it into the User name field. If you are
connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for Oracle and leave these fields empty in Database Wizard.

Database Wizard

Steps

1.5elect database
2.5et up ODBC connection

3. Set up user authentication

4.Save and proceed

Help

Set up the user authentication

Some databases require you to enter a user name.

User name myusername

Password reguired

Test Connection

<< Back Mext == Finish Cancel

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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= L L

Authentication Required ¥

Steps

1. Select database MESSEQE from server:

2.5et up ODBC connection A password is needed to connect to the data source .

3. 5et up user authentication

4. 5ave and proceed

Enter user name and password for:

User name
myusername

Password

—

Help Ok Cancel

Test Connection

Help << Back Mext = Finish Cancel

If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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Database Wizard *

Steps Decide how to proceed after saving the database

1.5elect datab . - - "
elect database Do you want the wizard to register the database in OpenOffice?

R LB LS ® Yes, register the database for me

3.5et up user authentication _
(O Mg, do not register the database

.ESEWE and proceed
After the database file has been saved, what do you want to do?

Open the database for editing
[] Create tables using the table wizard

Click 'Finish' to save the database.

Help << Back Mext = Einish Cancel

You will be prompted to give a name to your new database and select the directory where you
want to store it.

© 2024 Enter your company name



118 ODBC Driver for Oracle

£ save As >
= v P » This PC » Downloads * DB v O Search DB »

Organize - Mew folder 4=z o

B This PC ~ Mame Date modified Type
-J 3D Objects 2 New Database 05.06.2019 16:43  OpenDocumetr
B Deskiop
|j_: Documents
4 Downloads
D Music
&=| Pictures
B videos
e Local Disk (C)

- Mew Volume ([v <€

File name: | Mew Databaze

Save as type: | ODF Database

[+] Automatic file name Cancel
 Hide Folders extension

6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-
click the table name.
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i8 New Database21.0db - OpenOffice Base — O X
File Edit View Insert Tools Window Help X
i . . - |[AL|2p | R - i
H % [3 L=e ) l* A& ET e = 1 =

£ Use Wizard to Create Table...
El Create View...

[ Create Table in Design View.. Description

=
BB
Queries

DEPT 2 None +
= DETAIL
Forms DML_ARRAY

DML_ARRAY_TIMESTAMP
EMP

Reports EMPLOYEES

ENCRYPT TYPES

£ AUTOTEST.EMPLOYEES - New Database21 - CpenOffice Base: Table Data View = O ¥

Eile Edit View Insert Tools Window Help

=1 ICHERE S IR TR

ID | FRST.NAME | LAST_NAME | EMAIL JOB_TITLE CITY | UNNERSITY |
B Janek Ardern Jjardernd@va.gov iElectrical Engineer Buayan Universidad Cer
|2 Isis Krystek ikrystekl@mayoclinic.com Chemical Engineer Victoria University of Bal
N Addy Mullinder amullinder2 @fotki.com Graphic Designer Tajao Luxun Academy
|4 Eleen Deshorts edeshorts3@cdbaby.com Software Consultant Petrov Universit? de la
E Missy Strass mstrassd@photobucket.com Compensation Analyst | Meilong Kwansei Gakuin
|8 Sigvard Huard shuards@apache.org Geologist Il Chayek Chittagong Univ
. Dahlia Lennard dlennardé@webs.com Clinical Specialist Cimuncang  Rajitlal Institute
|z Liane McPheat Imcpheat?@jigsy.com Registered Murse Bobrovka Miles College
. Zollie Verity zveritys@thetimes.co.uk Web Designer Il Lincuo Kilimanjaro Chri
|10 |Tonia Mathey tmathey@@amazon.de Senior Financial Analyst | Maslog Bushehr Univers
_m Anni Burch aburcha@nbcnews.com Computer Systems Analys Kinalaglagan |University of Ho

7. To create an SQL query, click Queries in the Database pane, then click Create Queryin

SQL View...
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MNew Database.odb - OpenOffice Base -

Eile Edit Wiew [Insert Tools Window Help

B3 - E-@y ]
[ Create Query in Design View... Description
\E= (& Use wizard to Create Query Create a query entering an SQL statement dirs

Tables |§&|. Create Query in SQL View... |
F
EEE

i

ﬁ

Forms |

Enter your query in the query text box and click Run Query (F5). The date will be fetched
from the database and displayed in Open Office or LibreOffice, respectively.

£ New Database21.odb : Query1 - OpenOffice Base: Query Design — O X
File Edit WView |nsert Tools Window Help
2= B D Y
: M- NBIRT vI#)
ID | FRST_NAME | LAST_NAME | EMAIL | JOB_TITLE ary | UNIVERSITY
p |1 Janek Ardern jardern0@va.gov Electrical Engineer Buayan Universidad Central de »
2 Isis Krystek ikrystek1@mayoclinic.com Chemical Engineer Victoria University of Bahrain
3 Addy Mullinder amullinder2@fotki.com Graphic Designer Tajao Luxun Academy of Fine
4 Eleen Deshorts edeshorts3@cdbaby.com Software Consultant Petrov Universit? de la Reunic
5 Missy Strass mstrassd@photobucket.com | Compensation Analyst  Meilong Kwansei Gakuin Univer
6 Sigvard Huard shuardS@apache.org Geologist Il Chayek Chittagong University ¢
7 Dahlia Lennard dlennardé@webs.com Clinical Specialist Cimuncang  Rajitlal Institute of Tect
g Liane McPheat Imcpheat7@iiasv.com Reaistered Nurse Bobrovka Miles Colleae 9
Record [1 [ of 26 = ][]
SELECT * FRCM EMPLCYEES: ~
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

4.8 Usingin PHP

Connecting to Oracle from PHP using ODBC Diriver for
Oracle
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PHP is one of the most popular programming languages for website development. ODBC
drivers are connectors that make PHP development database agnostic — your software
written in PHP will function with any vendor's database management system. You can use
functions like odbc_exec() to prepare and execute SQL statements against any databases
like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-
based database. You can establish a connection to them using ODBC interface. With our
ODBC drivers, you can access various data sources and retrieve tables and fields from a
database.

Below is a sample PHP script for accessing Oracle via ODBC. The script connects to Oracle

database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the
function takes three mandatory parameters: the data source name, username and password.
If your database is not password-protected or doesn't require a username, leave these
parameters empty. In the following example, a connection is established using the
odbc_connect() function in PHP.

<?php
$user = "myusername";
$password = "mypassword";

$oDBCConnection = odbc_connect("Driver={Devart ODBC driver for Oracle};D

Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT
statement against the dept table in the autotest database.

$sQLQuery = "SELECT * FROM autotest.dept";
$Recordset = odbc_exec($0ODBCConnection, $SQLQuery);

Step 3: Print the result set

The odbc_fetch_row() function is used to return records from the result set. While
odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML
table. After all rows from the result set have been printed, the odbc_close() function closes
the connection.

while (odbc_fetch_row($Recordset)) {
$result = odbc_result_all($RecordSet, "border=1");
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odbc_close($0DBCConnection);
7>

You can modify this script by specifying general settings for each Devart ODBC driver to use

any of them with your PHP projects.
© 2015-2024
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Using in Power Bl

Importing Oracle Data into Power Bl Through an ODBC
Connection

Power Bl is a popular business intelligence solution that is comprised of services, apps, and
connectors that allow you to pull raw data from various sources and create meaningful
reports. To connect Power Bl to a data source such as Oracle, you can use a corresponding
ODBC driver.

This tutorial explores how to connect to Oracle and import data into Power Bl Desktop using
an ODBC driver. It is assumed that you have already installed and configured a DSN for
ODBC driver for Oracle.

1. Run Power Bl Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect
to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and
select the previously configured DSN for Oracle

4. If you would like to enter a SQL statement to narrow down the returned results, click the
Advanced options arrow, which expands the dialog box, and type or paste your SQL
statement.

5. Click OK. If your data source is password-protected, Power Bl will prompt you for user
credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents
of the database objects by clicking on them.

7. To load the Oracle data into Power Bl for analysis, select the needed table and click Load.
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Using in Python

Python module pyodbc and Oracle

Python is a popular general purpose scipting language that is also becoming popular among
web developers. If you want to use an Oracle database as a data storage for your Pyhon app,
this tutorial teaches how to connect Python to an Oracle database using ODBC driver, code
samples included. There are many ways to connect to Oracle database from Python,
including cx_Oracle, a Python extension module that enables access to Oracle database,
most of the applications though use either ODBC or JDBC driver to connect to Oracle. One
of the most convenient methods to connect to an external database or access cloud data
from Python is using the pyodbc Python module that implements the Python DB specification
and allows you to easily connect Python appplications to data sources with the Devart ODBC
driver for Oracle.

Installing pyodbc module and Oracle ODBC

If you don't have Python installed on your machine, go to the Python official website, download
the installer for your system and run it. You will also need to install the pyodbc module — the
easiest way to do that is by using the pip install pyodbc command in the Python interactive
mode. Oracle database storage comes with ODBC support, but in order to connect to Oracle
from Windows, macOS, or Linux, you must install ODBC driver for Oracle, otherwise the
pyodbc module will not be able to establish a connection to the database.

Next, you need to download the ODBC Driver for Oracle. To use the ODBC driver as a
translation layer between the application and the database, you need to configure it by
following the installation instructions.

Connecting Python to Oracle database via ODBC Driver

Below is a Python code example that connects to Oracle using ODBC driver. First we import
the pyodbc module, then create a connection to the database, insert a new row, and read the
contents of the EMP table while printing each row to the Python interactive console. If you
have ever connected to any relational database from Python, you will easily understand the
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code as we describe each line. To execute the script, you can type this code directly in the
interactive console or add the code to a file with the .py extension and run the file from the
command prompt.

Step 1: Connect

The pyodbc module is imported to provide the API for accessing Oracle database. The code
uses the driver named "Devart ODBC Driver for Oracle" to connect to the remote database.
Once a connection is established, you can perform CRUD operations on the database.

import pyodbc

cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for Oracle};Direct=True;Ho

Step 2: Insert a row into Oracle table

Here's a simple example of how to execute an insert statement to test the connection to the
database. The script inserts a new record to the EMP table.

cursor = cnhxn.cursor()
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535,

Step 3: Retrieve data from Oracle table

The cursor.execute() function retrieves rows from the select query on a dataset. The
cursor.fetchone() function iterates over the result set returned by cursor.execute() while the
print() function prints out all records from the table to the console.

cursor = cnxn.cursor()

cursor.execute('"SELECT * FROM EMP")

row = cursor.fetchone()

while row:

print (row)
row = cursor.fetchone()

Conclusion

We have shown you how to access Oracle database using Python, pyodbc and Devart
ODBC driver. This tutorial uses only a handful of lines of code to establish a connection and
demonstrate basic operations, but you can use the pyodbc module and our driver for Oracle
in a enterprise application in the production environment. Feel free to download Devart ODBC
driver for Oracle for free to evaluate its features. You can use the same steps to connect to
any data source using a Devart ODBC driver: basically, all you have to do is modify the
connection string, the pyodbc functions used in this tutorial work for any database.
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Using in QlikView

Connecting to Oracle from QlikView using ODBC Driver
for Oracle

This tutorial describes how to connect and configure QlikView to retrieve data from Oracle for
further analysis. QlikView is a data visualization tool that connects and pulls data from
different popular databases like MySQL, MongoDB, Oracle, SQL Server, Postgres, etc. to
present it in a single view. The business intelligence platform identifies relationships in your
data and discovers patterns and opportunities to support your decision making.

QlikView supports the ODBC connectivity interface for communication with external data
sources. An ODBC data source must be configured for the database you want to access.
You can create an ODBC connection using a DSN during the ODBC driver installation or

later.

To connect to an ODBC data source from QlikView using our driver for Oracle, perform the
steps below:
1. Open the QlikView client application and click File > New. Close the Getting Started

wizard and open File > Edit Script (CTRL+E).
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@ qlikview x64 Personal Edition - [av1]

{| File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help
{0 New Ctri+N || & | #a| v | [ | @) |5? B ¢ K Clear ~| @ Back &) Forward | & Lock &' Unlock
= open.. Ctrl+0
= Open in Server.. Ctrl+Shift+O
Open URL...
Open FTP...
Close
Favorites »
= save Ctrl+5
Save As... F12
Mail as Attachment...
Mail with Bookmark as a Link
| P . +P
Print Sheet...
Source Control »
Export »
| 4 Edit script... arl+e |

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select
the Data Source you created earlier, type in the User ID and Password if your database is
password-protected. You can test the connection by choosing Test Connection. The
Connection Test succeeded message should appear. Click OK to connect to your data

source.
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Q

File Edit Insert Tab

Tools

Help

-l Reload #Debug | [ S| & -2 @] O [0 <1 2 Tabs Main

v |22 =

3 e

[GET

Data  Functions ‘arables Settings
[ atabaze
| 0DBC v
[ Forze 32 Bit

Connect...

Select...

[1ata from Files =

[ Relative Paths
[JUzeFTR

@ Connect to Data Source

User ID Pazswond
|m_l,.lid | |ooooo| |

Data Sources

i}
Devart ODEC Drriver for ASE
Drewart ODBC Driveer for Firebird
Devart ODBC Driver for Interbase
Devart ODBLC Driver for bMagento
Devart ODBC Diiver for MailChimp
Diewart ODBC Diriver for MySEIL
Devart ODEC Driver for MetSuite
Dewart ODBC Driver for Oracle
Drewart ODBC Drriver for SOL Azure
Devart ODBC Driver far SOLite
Mesweart CNRC Ciniver for vRacs

[ Show User DSMs

Test Connection...

*

Canecel

Help

0k Catcel Help

3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.

Q Edit Script [Ch\Users\EvgeniyL\Documents\new.gvw™]

File Edit Insert Tab Tools Help
S} Reload [#Debug | =l S| 4 -2 @] &2 [0 <1 2 Tabs Main v |25 =
I air
ODBC CONNECT TO [Dewart ODBC Driver for Oracle];
SELECT * FROM AUTOTEST.EMPLOYEES;
Data  Functions  Variables  Settings
Databaze Data from Files
| aDeC - Connect... [ Relative Paths Table Files...
[JUzeFTP g :
] Force 32 Eit Select,.. EIsiEen (k..
Wb Files...
Field Data...
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Sheet Properties [Main] >

General Fields  Objects  Securty Triggers

Awvailable Fields Fields Displayed in Listboxes

CITY

EMAIL
FIRST_NAME
ID Add Al >
JOB_TITLE
LAST_NAME < Remove
UNIVERSITY

Add =

4. Alternatively, you can click Select, and QlikView will show you the database structure
window where you can compose a SELECT statement for the data to be fetched. You can
choose a different database from the database drop-down list. Select the necessary tables
and fields. You can retrieve date from multiple tables and fields by selecting them and
clicking Add. When you are ready with your SELECT statement, click OK. You will get
back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.

@ Create Select Statement = O *
[iata source |Devart ODBC Driver for Oracle | Connect..
Database Driver...
COwaner |,.'_\L|TDTE5T v| Support...

Database Tables Fields | Text Order ~ |
[ show 4l EMP ~ | I,
Tahles EMPLOYEES CITY
Views EMCRYPT_TYPES EhdayIL

ERRORMSG FIRST_MAME
[ Symaoryms

FISH ID v
System Tables | FLOAT TYPES ter T :
[ &liases IMTFRFR TYFFS ¥ | [ Show |con for Key Fields

Script  Table Columnz  Preview Blobs

SOL SELECT * (®) Column
FROM AUTOTEST.EMPLOYEES: O Row
() Stuctured
[ Preceding Load
Add
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5. Once the data has been fetched, you can choose a table layout to present the data in a
table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to

the tablebox and click OK.

) QlikView x64 Personal Edition - [C\Users\ ODBC\Documentsh 1.guw™]

File Edit View Selections | Layout | Settings Bookmarks Reports  Tools  Object Window  Help
P 5 Y | 4] )| 4 1 Add Sheet.. '?g i [l Clear ~| (& Back (3 Forward | (3|
i AW Promote Sheet
Main
re . Demote Sheet
id » L4
1408 AWl Remove Sheet
i £ |l SelectFields...
4 A1 New Sheet Object v | [E] List Box...
5 _ - -
6 #4 Rearrange Sheet Objects |Z] Statistics Box...
g #Y| Adjust Off-Screen Objects [El Multi Box..
5 Align/Distribute v [ Table Box..
sl [l Chart...
1 i
12 i i] Input Box...
13 = :
14 || Current Selections Box...
15 (2]} Button...
16 3
@ alikview x64 Personal Edition - [CA\Users\EvgeniyL\Documents\new.cvw*] - O X
! File Edit View Selections Layout Settings Bookmarks Reports Tools Objet  Window Help -8 X
PNE s WS E G0 O &l k] 2] @ »3'7! K clear *| @Back @) Forward | & Lock _:T'Unlock!
Main
= (..
ID FIRST_MAME LAST_MAME EMAIL JOB_TITLE CITY UNIVERSITY
25 Godwin Pahler gpahlero@ihg.... Programmer EB?stad Mational Taipei Teachers College
24 Myca Muncey mmunceyn@ya... Librarian Baiyun Universidad T?cnica de Ambato
13 Roda Hartford rhartfordc@chr... Software Test Engineer I Batobato National University of Laos
12 Malory Youthed myouthedb@st... Software Test Engineer II Bergen op Zoom Ecole d'Architecture de Nancy
16 Loleta Tumilty ltumiltyf@ihg.com Cost Accountant Bigiao University of Texas Pan American
8 Liane McPheat Imcpheat7@jig... Registerad Nurse Bobrovka Miles Callege
1Jangk Ardern jardernd@va.gov Electrical Engineer Buayan Universidad Central de Bayam?n
6 Sigvard Huard shuard5@apac... Geologist IT Chayek Chittagong University of Engineering and Technology
15 Roscoe Wainman rwainmane@sg... Sales Representative Cijoho Meijo University
7 Dahlia Lennard dlennardé@we... Clinical Specialist Cimuncang Rajitlal Institute of Technology & Health Sciences (RITHS)
26 Jan Camilio jeamiliop@spot... Structural Enginesr Desa Gegempa... Cheljabinsk University of Agriculbural Engineering
19 Marigtta Kleinmann  mkleinmanni@... Engineer II Fengshan Central Michigan University
11 Anni Burch aburcha@nben... Computer Systems Anal... Kinzlaglagan University of Houston
23 Arabelle Crossfeld acrossfeldm@i... Tax Accountant Lagea do Itaenga Tashkent Institute of Irrigation and Melioration
3 Zollie Verity zverityG@theti... Web Designer ITT Lincuo Kilimanjaro Christian Medical College
10 Tonia Mathey tmatheyd@am... Senior Finandal 4nalyst  Maslog Bushehr University of Medical Sdences
5 Missy Strass mstrass4@pho... Compensation Analyst Meilang Kwansei Gakuin University
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Using in SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to

perform various data migration tasks. When using Devart ODBC Driver for Oracle as a

translation layer between the data source and SSIS, the driver and SSIS communicate via

Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the sQLExecDirect function,

an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues

to fetch data from a data source via ODBC version 3.x. To prevent any issues when using
SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the

Advanced Settings tab and select ver 2.x from the obec Behavior dropdown.

General Advanced setfings License About

Meta Data
Connection
-
-
Compatibility
QDBC Behavior Ver 2, e
String Types Default b

|Use Local Regional Settings when converting to string

[]mumbers [ ]Dates and times

Test Connection - Cancel
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413 Usingin Tableau

This section describes how to establish and troubleshoot a connection to Oracle from
Tableau using ODBC Driver for Oracle.

e Using in Tableau

¢ Troubleshooting in Tableau

© 2015-2024
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4.13.1 Using in Tableau

Importing Oracle Data Into Tableau Through an ODBC
Connection

This article explains to establish and ODBC connection to Oracle from Tableau Desktop.
Tableau is a data visualization tool that allows you to pull in raw data, perform analysis on i,
and create meaningful reports to get actionable insights. With Tableau Desktop and our suite
of ODBC drivers, you can connect to various relational and non-relational databases, both
cloud and on-premise.

1. Run Tableau Desktop.

2. On the start page, select More... in the Connect pane.

3. Choose Other Databases (ODBC).

4. Expand the DSN drop-down list and select the DSN that you have created and configured
for Oracle. Alternatively, if you have not created a DSN, you can choose the Driver option
and select Devart ODBC Driver for Oracle from the drop-down.

. Click Connect.

. After a successful connection, click Sign in.

. Select the needed database and schema in Oracle.

. You should see the list of all tables you have access to in the connected data source.

© 00 N O O

. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the
data, or click New Custom SQL to write a query that will select only specific data from the

table.
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10.Hit Update Now to retrieve and display the data.
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4.13.2 Troubleshooting in Tableau

Troubleshooting ODBC Connection in Tableau

The default Tableau settings limit the number of rows to be retrieved through an ODBC
connection to 1,000. To overcome this limitation, create a Tableau Datasource Customization
(.tdc) file in 'Users\[your name]\Documents\My Tableau Repository\Datasources\' — for
example, devart-oracle.tdc, and add the following capabilities to the file:

<?xml version='1.0' encoding="utf-8"' ?>
<connection-customization class="genericodbc' enabled="true' version='"1.0'>
<vendor name='oracle' />
<driver name='Devart ODBC Driver for Oracle' />
<customizations>
<customization name='CAP_QUERY_TOPSTYLE_ROWNUM' value='no' />
<customization name='CAP_QUERY_TOP_N' value='no' />
<customization name='CAP_QUERY_TOPSTYLE_LIMIT' value='no' />
<customization name='CAP_QUERY_TOPSTYLE_TOP' value='yes' />
<customization name='CAP_SELECT_TOP_INTO' value='no' />
</customizations>
</connection-customization>

Troubleshooting ODBC Connection in Tableau on
macOS

The iODBC driver manager incorrectly handles the SQL_ WCHAR and SQL_WVARCHAR
ODBC data types. To work with these data types in Tableau, define an additional capability:

<?xml version='1.0' encoding="utf-8"' ?>
<connection-customization class="genericodbc' enabled="true' version="1.0'>
<vendor name='Oracle' />
<driver name='Devart ODBC Driver for Oracle' />
<customizations>
<customization name='CAP_ODBC_BIND_SUPPRESS_WIDE_CHAR' value='yes'
</customizations>
</connection-customization>
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